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Before You Start ... 
This tutorial is designed to give you a quick and practical 
introduction to all the important tools for designing and 
modifying in Allplan 2017. 

It contains several examples in the form of exercises. 
These are used to show how to design in 2D and how to 
get started in 3D modeling. 
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Requirements 
This guide assumes that you are familiar with and have a working 
knowledge of Windows and Allplan 2017.  
The basics are covered in the manual. In particular, you should know 

• How to start and exit Allplan 2017 

• How to create projects 

• How to open and close drawing files and how to set drawing files 
to edit or reference mode 

• How to control the on-screen display; in particular how to refresh 
your drawing and zoom in on details 

You should work through the exercises in the given sequence as 
tools that are presented in more detail in the earlier exercises are 
only referred to by name in later exercises. 
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Feedback 
We are always trying to improve the overall quality of our program 
documentation. Your comments and suggestions are important to us 
and we welcome feedback on the manuals and on-line help. 

Please do not hesitate to contact us to express criticism or praise 
concerning the documentation. Feel free to contact us as follows: 

 

Documentation 
 
Allplan GmbH 
Konrad-Zuse-Platz 1 
81829 Munich, Germany 
 
Email: dokumentation@allplan.com 
 

mailto:dokumentation@allplan.com
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Sources of information 
The Allplan documentation consists of the following: 

• The help is the main source of information for learning about and 
working with Allplan. 
While you work with Allplan, you can get help on the current 
function by pressing the F1 key, or activate  Help on the 
Default toolbar and click the icon on which you require help. 

• The Manual consists of two parts. The first part shows how to 
install Allplan. The second part is designed to provide an 
overview of basic concepts and terms in Allplan as well as 
introduce approaches for entering data in Allplan.  

• The Basics Tutorial guides you step by step through the most 
important tools for designing and modifying elements in Allplan. 

• The Architecture Tutorial guides you step by step through the 
process of designing a building. In addition, you learn how to 
analyze the building data using reports and to print the results. 

• The Engineering Tutorial guides you step by step through the 
process of creating key plans, general arrangement drawings and 
reinforcement drawings and shows you how to print the results. 

• New Features in Allplan provide information on what's new in 
the latest version. 

• Each volume in the Step-by-Step series deals with a specific 
concept or series of tools/modules in Allplan in detail. The areas 
covered include data exchange, system administration, geodesy 
modules, presentation modules, 3D modeling etc. As a 
Serviceplus member you can download these guides as PDF files 
in the Learn - Documents area of Allplan Connect 
(http://connect.allplan.com). 

 

http://connect.allplan.com/
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Additional help 

Tips on efficient usage 

The ? menu includes Tips for efficient usage. This topic provides 
practical tips and tricks showing you how to use Allplan efficiently 
and how to carry out operations with ease. 

User forum (for Serviceplus customers) 

Allplan forum in Allplan Connect: users exchange information, 
valuable tips relating to everyday work and advice on specific tasks. 
Register now at  
connect.allplan.com 

On the Internet: solutions to frequently asked questions 

You can find solutions to numerous questions answered by the 
technical support team in the comprehensive knowledge database at  
connect.allplan.com/faq 

Feedback on the help 

If you have suggestions or questions on the help, or if you come 
across an error, send an email to:  
dokumentation@allplan.com 

 
 

mailto:dokumentation@allplan.com
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Training, coaching and project support 
The type of training you are given is a decisive factor in the amount 
of time you actually spend working on your own projects: a 
professional introduction to the programs and advanced seminars for 
advanced users can save you up to 35% of your editing time! 

A tailor-made training strategy is essential. Our authorized seminar 
centers offer an extensive range of programs and are happy to work 
out a custom solution with you that will address your own needs and 
requirements: 

• Our sophisticated, comprehensive seminar program is the 
quickest way for professional users to learn how to use the new 
system.  

• Special seminars are designed for users who wish to extend and 
optimize their knowledge. 

• One-on-one seminars are best when it comes to addressing your 
own particular methods of working. 

• One-day crash courses, designed for office heads, convey the 
essentials in a compact format. 

• We are also happy to hold seminars on your premises: These 
encompass not only Allplan issues but include analysis and 
optimization of processes and project organization. 

For more detailed information on the current training program, 
please consult our online seminar guide you can find on our 
homepage (http://www.allplan.com/de/events/termine/schulungen-
kurse-cad-ava-d2c-fm.html).  
 

http://www.allplan.com/de/events/termine/schulungen-kurse-cad-ava-d2c-fm.html
http://www.allplan.com/de/events/termine/schulungen-kurse-cad-ava-d2c-fm.html
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Unit 1: Introduction 
This unit briefly introduces the seven exercises in this 
tutorial. 

You will create a separate project for these exercises. 
Then you will make basic settings which apply to all the 
exercises.  

A short troubleshooting section is provided at the end to 
make sure you succeed. 
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Objectives 
In exercises 1 to 6 you will learn how to use the following modules: 

•  Draft, 

•  Text and 

•  Dimension Lines. 

These three modules belong to the Basic family. 

The last exercise gives you a quick and practical introduction to the  

•  3D Modeling 

module in the Bonus Tools family. 
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Exercise 1: File Cabinet with Drawers 

• Precision drafting using reference points 

• Using the tools in the Point Assistant (shortcut menu) 

• Basic edit tools 

• Modifying the offset between parallel lines 

• Stretching entities 

• Copying and rotating elements 
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Exercise 2: Retaining Wall with Drainage 

• Delta point 

• Hatching and hatching definition 

• Polyline entry tools 
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Exercise 3: Purlin Roof 

• More tools for editing elements 

• Creating labels with leaders 
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Exercise 4: Rotary 

• Creating a circle 

• Area detection 

• Patterns and pattern definition 
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Exercise 5: Title Block 

• More tools for editing elements 

• Creating and saving symbols 

• Retrieving symbols from the library 
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Exercise 6: Precast Balcony Unit 

• Creating and modifying dimension lines 

• Hatching and hatching definition 
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Exercise 7: Rietveld Chair 

• Introduction to 3D modeling 

• Using a work plane 
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Creating the project 
You work with drawing files and NDW files in Allplan 2017. 
Drawing files are organized by project. 

You will start by creating a project for the exercises in this tutorial.  

To create a project 

1 After having started Allplan 2017, you can create a new project 
straight from the welcome screen. Click the corresponding tool 
and continue with step 4. 

 

2 If you have switched off the welcome screen, open the File menu 
and click  New Project, Open Project.... 

3 The New Project, Open Project dialog box opens. Click  New 
Project. 
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4 New Project – Specify Project Name  
Enter the project name: Basics Tutorial. Do not use a project 
template for the new project. 
Click Next >. 

 

5 You will define new patterns and hatching styles as you go 
along. You will use project-specific settings so that you do not 
change the office standard inadvertently. 
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Set all Path settings to Project and click Finish to confirm the 
dialog box. 

 

Allplan creates the Basics Tutorial project and opens it 
automatically. 

 

Path settings: 
These define whether the pens, line types, hatching styles, fonts and 
material catalogs available in that project are based on the office 
standard or whether they are project-specific. In practice, the office 
standard is generally used. 

Office: 
Choose this option if you want different projects within the same 
office to use the same settings (for hatching, line types etc.). If you 
work on a network, the office standard is the same on all computers 
and can only be changed by users with special privileges. 

Project: 
Choose this option if you want the settings, for instance for patterns 
and hatching styles, to apply to this project only (in which case they 
will probably be different to those used as the office standard). 
 

Note: 
Organizing projects is 
described in detail in the help 
for Allplan and in the 
Architecture Tutorial. 
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Understanding drawing files 

In Allplan, the actual design and data creation process happens in 
drawing files. These are the equivalent of the transparencies used in 
conventional building design. Drawing files can be used to give 
projects a structure. In IT terms, a drawing file is a conventional file 
stored on your hard disk. You can display and edit up to 128 
drawing files at once - in other words, you can have several files 
open simultaneously. A project can contain up to 9999 drawing files. 
When working without layers, the individual building elements (such 
as walls, stairs, labeling, etc.) are drawn on different drawing files 
and superimposed like transparencies. 

 

In order to edit the drawing files, they have to be activated (opened). 
You can do this using the Open on a project-specific basis: drawing 
files from fileset/building structure dialog box. 

 

Drawing file status 

With the drawing file status, you define the drawing file on which 
you draw and which drawing files are visible and can be modified.  
The following illustration shows the different drawing file statuses. 
You can find an explanation in the table below. 
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Number Drawing file 
status 

Comment 

1 Current The current drawing file is the one in which you draw. There must always 
be one current drawing file. 

2 Open in edit mode Elements in drawing files open in edit mode are visible and can be 
modified. Up to 128 drawing files can be open simultaneously (regardless 
of whether they are current, in edit or reference mode). 

3 Open in reference 
mode 

Elements in drawing files open in reference mode are visible, but they 
cannot be modified. You can configure the program to use the same color 
for all elements in reference drawing files. To do this, select the  

 Options, click Desktop environment and open the Display page. You 
cannot open empty drawing files in reference mode. 

4 Not selected Elements in these drawing files are not visible. 

5 Empty Empty drawing files have no data type icon. 

6 Assigned 
temporarily 

The drawing file is assigned temporarily to the fileset. Allplan clears this 
assignment as soon as you switch to a different fileset. 

7 Open in reference 
mode 

The drawing file has been opened by another user in the workgroup 
environment. 

8 Open in reference 
mode 

The drawing file has been opened by another user in the workgroup 
environment; the color red indicates that the drawing file has changed. 
You can apply the changes by selecting Update drawing file on the 

shortcut menu. Using the  Options, Desktop environment page, you 
can configure the program to inform you of changes in reference drawing 
files. 

9 Update locked Using the shortcut menu, you can prevent the update of drawing files in 
which you generate views and sections for objects derived from the 
building structure.  You cannot update the result until you unlock the 
drawing file in question. But you can create a new view or section in such 
a drawing file after you have confirmed a prompt. 
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Basic settings 
Next, make settings that you will use in the exercises.  
 

Palette configuration 

The palette configuration is set by default in Allplan 2017. You can 
see the Tools, Properties, Wizards Library, Objects, Connect and 
Layers palettes on the left and the Filter Assistant and Edit toolbar 
on the right. 

 

You can use the first three palettes to access the families, the 
modules and their tools, the properties of design entities and the 
wizards.  

 



 

22 Basic settings Allplan 2017  

When the Tools tab is open at the top, the following options are available: 

Dropdown menu at the top Tabs on the right Available tools 
 

Select a family: Select a module: Select a tool in the Create and 
Change areas: 
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When the Properties tab is open at the top, the following options are available: 

Dropdown menu at the top Tools at the top and bottom Element properties 
 

Select active elements  Filter step by step 
 Zoom in on selected  

     objects 
 Match parameters 
 Load favorite 
 Save as a favorite 

Modify properties 
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When the Wizards tab is open at the top, the following options are available: 

Dropdown menu at the top Tabs on the right Available tools 
 

Select a wizard group Select a wizard Select a tool 
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The Library palette includes a  Filter you can use to show or hide 
specific types of library elements (symbols, smart symbols, 
SmartParts and PythonParts).  
After having opened a folder, you can see all subfolders with library 
elements (symbols, smart symbols, SmartParts and PythonParts), 
provided you have not filtered out library elements. You can select 
the objects you want to use. You can also add your own objects to 
the corresponding library folders. 

   

The Objects palette lists all objects and elements in the currently 
open drawing files (current or open in edit mode or open in 
reference mode). You can sort these objects by topology, drawing 
file, layer or material. You can show or hide the individual objects as 
you need. You can even activate or deactivate objects and elements 
using the Objects palette. 
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The Connect palette takes you straight from Allplan to content 
provided by Allplan Connect. You can enter your user name and 
password either directly in the palette or on the Palettes tab of the 
Customize... tool (Tools menu). 
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Using the Layers palette, you can access the layer structure quickly 
and easily. The palette displays the entire layer hierarchy. You can 
define the visibility of layers, change the layer status, select the 
current layer and choose privilege sets and print sets. 

 

Note:  
You can customize the arrangement of the palettes for your needs 
using the Palettes tab of the Customize... tool (Tools menu). You can 
show and hide the individual palettes as you need.  
As an alternative, open the shortcut menu of a palette and select 
Customize.... 

Settings in the Tools palette 

You will use the tools in the Draft module for the first exercises. 
Select the Draft module in the Tools palette. 

To make settings in the Tools palette for the exercises 
that follow 

1 Select the Tools tab in the palette. 

2 Select the Basic family on the dropdown menu. 

3 Use the tabs on the right to select the  Draft module. 
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Allplan presents the tools in the Draft module in the Create and 
Change areas. 

 

Note: You can use Hide automatically to show ( ) and hide ( ) 
the palettes. 
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Track tracing 

Track tracing helps you design intuitively. As you usually work with 
fixed measurements in the following exercises, you do not need 
track tracing.  

To switch track tracing on and off 

1 In the Tools palette, click  Line (Draft module - Create area). 

2 Click in the workspace with the right mouse button and select  
 Track tracing options on the shortcut menu. 

3 Switch Track tracing off. 

 

4 Click OK to confirm the settings and press ESC to quit the  
 Line tool. 

5 Repeat these steps to switch track tracing on again. 
 

Tip: You can quickly switch 
track tracing on and off at 
any time while entering 
points. Just press the F11 key 
or click  Track line in the 
dialog line. 
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Options 

You can set defaults for each of the modules in Allplan. 
You will use the unit m for the following exercises. 

To set the options  

1 Click  Options (Default toolbar). The Options dialog box 
opens. Select Desktop environment in the area on the left. 

2 Check the Enter lengths in option in the General area on the 
right. If it is not set to m, click the button and select m.  

 

3 Click OK to confirm the settings. 
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Pen settings 

Before you start drawing, you need to define the line thickness (pen) 
and the line type on the Format toolbar. You can change these 
settings at any time while you are drawing or later. 

Each element can be given one of Allplan's 256 line/element colors. 
However, the manner in which elements are displayed on screen 
depends on the setting of the Color stands for pen option in  

 Show/Hide (Default toolbar):  

• When the Color stands for pen option is selected, the element is 
automatically displayed in the color that is associated with the 
current pen thickness (this is the default setting). 

• When the Color stands for pen option is not selected, the 
element is displayed on screen using the line color you selected. 

To set the pen and line type 

1 Click Select Pen Thickness on the Format toolbar and set it to 
0.25 mm. The selected pen is displayed. 

 

2 Click Select Line type and choose Line type 1 (a continuous 
line). 

3 Click Select Line Color and choose Color 1 (black). 
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All the exercises in this guide are drawn with these basic settings 
even if this is not specified explicitly. 

Allplan provides two different options for structuring drawing files: 

• The building structure. 

• The fileset structure 

You can use these two structures in parallel manner. The building 
structure is particularly useful for applying a logical structure to a 
building. 
As the exercises in this tutorial do not build on one another, a 
separate drawing file is used for each exercise.  

 
 

Controlling on-screen display 
Allplan offers various tools you can use to control how your model 
and its design elements appear on the screen. Thus, you can always 
choose the tool best suited to the task at hand. 

You can find these tools in various places in Allplan, for example on 
the View menu, on the shortcut menu and on the viewport toolbar. 
You can even use the keyboard and mouse to control the display on 
the screen. 
 

Tools on the viewport toolbar 

Using the tools on the viewport toolbar, you can not only navigate 
freely on screen but also set any view. You can zoom in on any 
section or detail of your drawing as closely as you want. You can 
even use different view types to display the entire model or selected 
components. 

Most of these tools are ‘transparent’ tools; in other words, you can 
use them while another tool (e.g. Line) is active. 

You cannot see the viewport toolbar until you move the cursor to 
the bottom of the viewport, guaranteeing as large a workspace as 
possible. If you are working with multiple viewports, each viewport 
has its own viewport toolbar. 
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Icon Function Use 

Area on the left:  

 
View flyout Using the View tool or the  Standard views flyout, you can 

choose between plan view and any of the standard views. 

 
Zoom All  Zoom All sets the display scale so that you can see all the 

elements in the visible files. 
 

Note: But if you have loaded a view using  Save, Load View, 
Allplan displays only this view. 

 
Zoom Section  Zoom Section zooms in on a section. To do this, press and hold 

down the left mouse button and enclose the elements you want to 
zoom in a selection rectangle. 

 
Navigation Mode  Navigation Mode enables the navigation mode in the current 

viewport. In this mode, you can use the mouse to view a 3D model. 
 
Note: in navigation mode, you can navigate in sphere mode or in 
camera mode (keep the CTRL KEY pressed down). 

 
Previous View  Previous View restores the previous view or display scale set 

(provided you had selected a different view or scale before you 
selected the current setting). 

 

 
Next View  Next View restores the next view or display scale set (provided 

you have already selected a subsequent view or scale). 
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Save, Load View Using  Save, Load View, you save the current view under a 

name of your choice or retrieve a view you saved beforehand. 

 
3D View You can use  3D View to display 3D models in three-

dimensional space in a perspective view by entering an eye point 
(observer) and target point. You can also use this tool to create a 
view based on the building structure. 

 
Element Selection Using  Element Selection, you select the design entities you 

want to display in the current viewport. The program temporarily 
hides all the other design entities. 

 
Drawing File Selection You can use  Drawing File Selection to temporarily hide 

drawing files that are currently visible in the active viewport. 

Click  Drawing File Selection again to restore the initial 
situation in the active viewport. As a result, you can see all the 
drawing files that had been visible before you selected this tool. 

  
 
or 
 

 

Always on Top  Always on Top places the viewport so that it is always on top 
(i.e., in front of) the other ones. 
 
You can use this tool only if you have not selected the Connected 
option and the viewport is not maximized. 
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Area on the right:  

 
Exposure (only for 
Animation and 
RTRender). 

Using Exposure, you can control the brightness in a viewport of the 
Animation or RTRender view type. You can enter a value between -
25 and 25. 
 
Important! 
This setting only applies to the current viewport. It has no effect on 
the settings used for rendering. 

 
Section Display Using the  Activate Section tool or the Section Display list box, 

you can display your design in an architectural section (provided 

you defined its  Clipping Path beforehand). 

 
Display Scale You can use Display Scale to set the scale for displaying the model 

on screen. 
 
The display scale governs the ratio between the model as displayed 
on the screen and its real-life dimensions. The scale therefore 
changes automatically if you change the size of sections displayed 
on screen. The current display scale is shown on the viewport 
toolbar in the lower border of a viewport. 

 
View Type Using the View Type list box, you can select one of the predefined 

view types (Wireframe, Hidden, Animation, Sketch or RTRender) 
for the current viewport. Of course, you can also select a view type 
you defined yourself. 
 

Click  to modify various settings of the view types. The settings 
apply to all the viewports using this view type. Click New view 
type... to define and save your own view types. 
 

When you are working in the layout editor (  Layout Editor is 
pressed in), you can switch between Design view and Print view (= 
preview of resulting printout). 

   
 

Note: You can find more tools for controlling the on-screen display 
on the View and Window menus and on the shortcut menu (only in 
navigation mode). 
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How to ... 
Sometimes, things will not immediately work out as required. This 
list helps you succeed. 
 

What if  … 

• ... I have selected the wrong tool? 
Press ESC and click the correct icon. 

• ... I make a mistake as I go along? 
Press ESC to quit (several times if necessary).  
Click  Undo. 

• ... I have inadvertently deleted the wrong elements? 
If  Delete is still active, press the right mouse button twice. 
If no tool is active, click  Undo. 

• ... I have unintentionally opened a dialog box or entered wrong 
values? 
Click Cancel. 

 

And what if ... 

• ... the workspace is empty but you are sure the drawing file 
contains design data? 

- Click  Zoom All (viewport toolbar). 

- Click  Plan. 

• ... the workspace is suddenly divided into a series of different 
viewports? 
On the Window menu, click  1 Viewport. 

• ... specific kinds of elements such as text or hatching do not 
appear in the workspace? 
Click  Show/Hide (Default toolbar) and check that the 
elements in question are selected. 

Tip: Check whether the 
relevant layer is set so that it 
is visible. 
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Unit 2: Designing and 
Modifying 2D Elements 

This unit presents Allplan 2017's basic 2D tools. In 
particular, you will learn 

 How to place points precisely 

 How to work with track tracing and direct object 
modification 

 How to modify existing elements 

 How to apply hatching and patterns - you will 
familiarize yourself with the polyline entry tools, 
which are used by countless Allplan tools. 

 How to modify and redefine hatching styles and 
patterns 

 How to create labels with leaders 

 How to create a title block and save it as a symbol 

 How to dimension components 
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Exercise 1: File Cabinet with Drawers 
In this exercise you will design a file cabinet with drawers. After 
this, you will modify the height of the file cabinet. 

 

Use the  Draft module in the Basic family to do this. 
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Task 1: designing the file cabinet 

The first exercise shows how to draw rectangles and how to copy 
and mirror elements. In addition, you will learn how to use the 
Reference point, Point of intersection and Midpoint functions for 
precision drafting. 

 

Tools: Objective: 

 Point snap options 

 

 Point snap and offset 
entry 

 Offset Polyline 

 Circle 

 Midpoint 

 Copy 

 Options, desktop 
environment, direct 
object modification 

 Copy and Mirror 

 Delta point 
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Drawing the file cabinet as a rectangle 

To draw the file cabinet as a rectangle 

1 Click  Open on a Project-Specific Basis. 

2 You do not need to create a building structure for this tutorial. As 
the exercises in this tutorial do not build on one another, you will 
use a separate drawing file for each exercise. Therefore, click 
Cancel. 

 

The Open on a project-specific basis: drawing files from 
fileset/building structure dialog box opens and you can see the 
Building structure tab. 

3 The Basics Tutorial has 10 drawing files.  
Click drawing file number 1 and click a second time inside the 
selection or press F2. 

You can now enter a name for the drawing file. 
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4 Type in File cabinet and press ENTER to confirm.  

 

5 Click Close. 

6 Click  Rectangle in the Tools palette (Basic family - Draft 
module - Create area).  
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7 Click  Based on diagonal line in the input options.  

Note: Check that  Create rectangle as a polyline is not active 
in the input options, as you will edit individual lines of the 
rectangle later.  

8 Click in the workspace to place the first point of the rectangle. 

9 The length of the rectangle in the x-direction is 1.8 m.  
Enter  dx = 1.8 in the dialog line. Press the TAB key  
to activate  dy. 

10 The height of the rectangle in the y-direction is also 1.8 m. Enter 
 dy = 1.8 in the dialog line and press ENTER to confirm. 

The file cabinet is displayed as a rectangle in the workspace. 

 

11 Press ESC to quit the  Rectangle tool. 
 

Tip: To switch between 
,  and  in the dialog 

line, use the TAB key or 
SHIFT+TAB. 
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A note on creating a rectangle as a polyline 

 

You can use the  Create rectangle as a polyline option in the 
input options to do the following: 

• If  Create rectangle as a polyline is active, the rectangle is 
created as one connected element, which you can select with one 
mouse click.  

• If  is not active, the rectangle consists of individual lines that 
you can select separately by clicking or as an entity group by 
pressing the SHIFT key while clicking.  

 

Drawing the file cabinet using offset polyline 

The next step is to draw the frame of the file cabinet using the Offset 
Polyline tool. You will use Point Snap as an aid to precision 
drafting. 

To draw the file cabinet using offset polyline 

1 Click  Offset Polyline in the Tools palette (Basic family - Draft 
module - Create area). 
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2 Enter the following values in the dialog line and press ENTER to 
confirm after each one. 
Number of parallel offset lines:  1 
Offset:  0.05 

3 Click the top right corner of the rectangle. 
Right is active in the input options. 

4 Open the shortcut menu by right-clicking in the workspace. 
Select  Point snap options and select all the options on this 
page except Grid point and Reference point of dimension line.  
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As soon as you point to a point, the system will snap to this 
point. The point snapped is marked with a red X. 

5 To draw the new rectangle outside the existing one, click the 
corners of the file cabinet in a counter-clockwise direction. To 
close the polyline, the last corner you click should coincide with 
the first one. 

 

6 Press ESC to quit the  Offset Polyline tool. 
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A note on direction in which the offset polyline is entered  

When using  Offset Polyline, pay attention to the connection 
between the setting in the input options and the direction in which 
you enter the polyline:  

• When set to right, you must enter the points in a counter-
clockwise direction to draw the outer rectangle. Entering the 
points in a clockwise direction produces the inner rectangle. 

• When set to left, it is the other way round.  

When set to right: 

 

(1) Direction 
(A) Negative offset 
(B) Positive offset 

To the left: 

 

(1) Direction 
(A) Negative offset 
(B) Positive offset 
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Designing drawers 

Next create a drawer using the Rectangle tool. Allplan provides a 
number of tools to help you place points with great precision. In the 
following section, you will design the drawer by snapping to points 
and entering offset values. 
 

To design a drawer 

1 Click  Rectangle in the Tools palette (Basic family - Draft 
module - Create area). 

Note: Check that  Create rectangle as a polyline is not 
selected in the input options. Otherwise, the rectangle can only be 
addressed as a single entity. As you need to copy individual lines 
of the rectangle later, it is essential that the lines can be selected 
individually.  

2 Check that  Delta point is active in the dialog line. 

3 To specify the rectangle’s start point, point to the bottom left 
corner of the inner cabinet line. 

The system snaps to this point, which is indicated by a blue 
CursorTip displayed with the crosshairs. A red X is now displayed 
on this corner, and the  X coordinate and  Y coordinate 
boxes are highlighted in yellow in the dialog line. 

4 If necessary, press the TAB key to activate the  X coordinate 
box and enter 0.02. 

A red point symbol (+) moves to the right. 

 



 

48 Exercise 1: File Cabinet with Drawers Allplan 2017  

5 Click the corner or press ENTER to confirm.  
The first point of the drawer is now defined. 

6 Enter the coordinates of the diagonally opposite point of the 
rectangle in the dialog line: 

 dx = 0.56 
 dy = 0.30 

Press ENTER to confirm. 

 

7 This completes the first drawer. You will design the other drawers 
based on this first one. 

8 Press ESC to quit the  Rectangle tool. 
 

A note on placing points using point snap and offset entry 

• Point to a point (do not click!): 
The system snaps to this point, the data entry boxes in the dialog 
line are highlighted in yellow. 

• Enter the relative dX and dY coordinates in the dialog line. 

• Press ENTER to confirm: the point is defined. 
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Creating the knob 

Next create the knob of the drawer using the Circle tool. To position 
the knob exactly, you will use the Midpoint option. 

To draw a knob 

1 Click  Circle in the Tools palette (Basic family - Draft module 
- Create area). 

2 The Circle Context toolbar opens. Click  Circle based on center 
and  Enter full circle. 

3 To define the first point, open the shortcut menu and click  
 Midpoint. 

4 First click the bottom left corner of the drawer. 

5 Then click the top right corner of the drawer.  
The center of the circle is defined. 

6 Enter a radius of 0.02 in the dialog line and press ENTER to 
confirm. 

 

7 Press ESC to quit the tool. 
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Copying the drawer 

You can create the other drawers by Copying the first one. 

To copy the drawer 

1 Use the left mouse button to enclose the entire drawer in a 
selection rectangle (from bottom left to top right: positive x-
direction). 

 

The knob is also selected as it is within the selection rectangle. 

2 Point to a line of the drawer and click  Copy on the context 
toolbar. 

 

Tip: Elements can be selected 
by enclosing them in a 
selection rectangle.  Select 
elements based on direction 
(Filter Assistant toolbar) is 
the default setting: when you 
open the selection rectangle 
in the positive x-direction, 
only the elements that are 
fully bounded by the 
selection window are 
selected; when you enter the 
selection rectangle in the 
negative x-direction, all the 
elements that are fully or 
partially bounded by the 
selection window are 
selected. 
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3 From point or enter offset: 
Click the bottom left corner of the drawer. 

 

The drawer with the knob is attached to the crosshairs (at the 
corner you just clicked). 

4 Go to the coordinate dialog box and set the  Number of copies 
to 5 (do not press ENTER to confirm!). 

5 To point or enter offset 
To define the drop-in point, point to the top left corner of the 
drawer so that Allplan snaps to this point. 
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6 Click the drop-in point snapped. 

Allplan creates the drawers on the left. 

7 Press ESC to quit direct object modification. 

 
 

Note:  
You can use the Filter Assistant to specify how and which elements 
are selected by the selection rectangle: 

 Selects the elements that are fully bounded by the selection 
rectangle. 

 Selects the elements that are fully or partially bounded by the 
selection rectangle. 

 Selects the elements that are partially bounded by the selection 
rectangle. 
 



 

Basics Tutorial Unit 2: Designing and Modifying 2D Elements 53 
 

Mirroring drawers 

Next you will mirror the drawers to the right-hand side. To do this, 
you will use the Copy and Mirror tool. The center axis of the file 
cabinet will serve as the mirror axis. 

To mirror the drawers to the right 

1 To select the drawers, enclose them in a selection rectangle using 
the left mouse button (from bottom left to top right: positive x-
direction). 

 

2 Point to a selected element, for example, a line. 
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3 The context toolbar for direct object modification opens, 
providing four tools: 

 

You can add two more tools to it. 
To do this, click  Options (Default toolbar). 

4 Open Desktop environment - Direct object modification and 
drag the  Copy and Rotate and  Copy and Mirror tools one 
after the other into the context toolbar. 

 

 



 

Basics Tutorial Unit 2: Designing and Modifying 2D Elements 55 
 

5 Click OK to close the Options dialog box. 

6 Select the drawers again by enclosing them in a selection 
rectangle. 

7 Point to a selected element, for example, a line. 

The context toolbar opens. Now it contains six tools. 

8 Click  Copy and Mirror on the context toolbar. 

 

9 Define the center axis of the file cabinet as the mirror axis. 
Move the crosshairs to the top line of the file cabinet, open the 
shortcut menu and click  Midpoint. 

Allplan snaps to the midpoint; this point defines the first point of 
the mirror axis (see illustration below). 

10 To define the second point of the mirror axis, move the crosshairs 
to the bottom line of the file cabinet and, on the shortcut menu, 
click  Midpoint again. 
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A = Mirror axis 

Allplan copies the drawers to the right. 

 

11 Press ESC to quit direct object modification. 
 



 

Basics Tutorial Unit 2: Designing and Modifying 2D Elements 57 
 

Creating a knob for the door in the middle 

Finally, you will draw a knob for the door in the middle. To do this, 
you will use the Midpoint and Based on center options. 

To create a knob for the door in the middle 

1 Click  Rectangle in the Tools palette (Basic family - Draft 
module - Create area). 

2 Click Based on center in the input options. 

 

3 Open the shortcut menu and choose  Midpoint. Then click two 
diagonally opposite corners of the door in the middle. 
This defines the center of the rectangle. 

4 Enter 0.1 for the length and press ENTER to confirm. 

5 Enter 0.01 for the width and press ENTER to confirm. 

 

6 Press ESC to quit the tool. 
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Task 2: modifying the file cabinet 

Based on the file cabinet designed beforehand, you will now create a 
new cabinet that is 2.1 m high. This cabinet has seven drawers. Start 
by copying the design to a new drawing file. Then you will modify 
the design. In this section you will find out about the two most 
important modification tools: Parallel Lines and Stretch Entities.  

 

Tools: Objective: 

 Copy, Move Elements 
between Documents 

 

 Stretch Entities 

 Parallel Lines 

 Brackets 

  

 
 



 

Basics Tutorial Unit 2: Designing and Modifying 2D Elements 59 
 

Copying a drawing file 

Begin by copying the file cabinet you created in the last exercise to a 
new drawing file. 

To copy the drawing file with the file cabinet 

 Only drawing file 1 File cabinet should be open. 

1 Open the File menu and click  Copy, Move Elements between 
Documents.... 

2 Activate Copy and click OK to confirm. 
 

 

3 Select an empty drawing file (for example, drawing file 2) and 
click OK to confirm. 

4 The system prompts you to select the elements you want to copy 
to the new drawing file. 

You want to copy all elements in the drawing file. Therefore, 
double-click the right mouse button in the workspace or click All 
in the input options. This copies the file cabinet to the new 
drawing file. 

5 Click  Open on a Project-Specific Basis and select the drawing 
file to which you have just copied the file cabinet. 
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6 Enter a name for drawing file 2, for example, Modified file 
cabinet. 

 

7 Make drawing file 2 current, close drawing file 1 and close the 
dialog box. 

8 Click  Zoom All (viewport toolbar) to display the file cabinet 
in its entirety on screen. 

 

Note: If you want, you can place the toolbar for controlling the on-
screen display at the top of the viewport. To do this, open the View 
menu, point to Toolbars and click Viewport toolbar at the top. 
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Stretching entities 

The next step involves modifying the two top corners of the file 
cabinet. This way, the file cabinet is given a new height of 2.1 m. In 
addition, you will add two drawers using the Copy tool. To do this, 
you will use direct object modification. 

To stretch entities 

1 Click  Stretch Entities (Edit toolbar). 

2 Select all the points on the entity you want to stretch. Make sure 
you select the two top drawers together. 

 

3 From point  
Click the top left corner of the file cabinet. 

4 To point  
The height of the file cabinet is to be 2.1 m; in other words, you 
need to lengthen it by 0.3 m in the y-direction. Click  Delta 
point in the dialog line and enter  dy = 0.30. 

 

Tip: You can also enter the 
values in the dialog line 
without clicking a start point: 

 dx = 0 
 dy = 0.30 
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Press ENTER to confirm. 

5 Press ESC to quit  Stretch Entities. 

6 Select the elements that make up the two incomplete drawers 
(two lines and circles each) by enclosing them in a selection 
rectangle using the left mouse button (from bottom left to top 
right: positive x-direction). 

 

7 Point to one of the two selected lines and click  Copy on the 
context toolbar. 
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8 From point 
Click the bottom left corner of the incomplete drawer on the left. 

 

9 Place point (to point) or enter the number of copies 
Press the TAB key to switch to  in the coordinate dialog box 
and enter dy = 0.30.  
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10 Press ENTER to confirm. 

 

11 Press ESC. 
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A note on selecting and modifying several elements and 
regions together using the brackets 

As an alternative to the selection rectangle, you can use the brackets 
to select elements one after the other. Do the following: 

• Activate an edit tool. 

• Open the brackets by clicking  Brackets (Filter Assistant or 
right-click in the workspace). 

• Click the elements one after the other or open selection rectangles 
around the elements you want to select. 

• To unselect an element, simply click it again. 

• Close the brackets by clicking  Brackets. 
 

Adding a frame 

To finish, you can now enhance the file cabinet by adding a frame to 
the door in the middle. To do this, use the Parallel Lines tool. 

To add a frame 

1 Click  Parallel Lines in the Tools palette (Basic family - Draft 
module - Create area).  
The system prompts you to select an element.  
Click the inner cabinet edge on the left-hand side. 

2 Point through which element is to pass / enter offset: 
Enter 0.6 in the dialog line and press ENTER to confirm. 

3 Which side? 
Click in the workspace to the right of the line. 

4 Number: 
Enter 1 and press ENTER to confirm. 

5 The  Parallel Lines tool is still active. The distance to the next 
line is calculated based on the new line you just created. 

6 Enter 0.6 in the dialog line and press ENTER to confirm. 
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7 Number: 
Enter 1 and press ENTER to confirm. 

 

8 Press ESC to quit the tool. 
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Exercise 2: Retaining Wall with Drainage 
In the following exercise, you will design a cross-section of a 
retaining wall with drainage. 

 

Use the  Draft module in the Basic family to do this. 
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Task 1: designing a retaining wall with drainage 

In this section, you will learn how to use delta points to create lines 
that are not parallel to the x and y axes. Delta points allow you to 
place a point at a specific distance from an existing point. 

To do this, use  Delta point in the dialog line. 

Tools: Objective: 

 Line 

 

 Delta point 

  Circle 

 Track line  
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Retaining wall of angular shape 

To draw the retaining wall 

1 Click  Open on a Project-Specific Basis and open an empty 
drawing file. Name it Retaining wall and close all the other 
drawing files. 

 

2 Click  Line in the Tools palette (Basic family - Draft module - 
Create area). 

3 The Line Context toolbar box opens. Select  Polyline and click 
where you want the line to start. 

4 <Line> To point 
Enter  dx = 3.00 in the dialog line and press ENTER to 
confirm. 

5 <Line> To point  
Enter  dy = 0.30 in the dialog line and press ENTER to 
confirm. 

 

Tip: Check that Element is 
active in the  Point snap 
options. To check this, click 
the right mouse button to 
open the shortcut menu.  
Click  Point snap options. 
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The next point is not at right angles to the previous point. 
However, you know the offset values in the x-direction and y-
direction. Use  

 Delta point to place this point. 

6  Delta point is active in the dialog line.  
Enter the following values:  

 dx = -2.00 
 dy = 0.20 

 

7 Press ENTER to confirm. 

 

Use  Delta point again to place the next point. 

8 Enter the following values in the dialog line:  
 dx = -0,2 
 dy = 4.0 

 

Tip: Pressing the TAB key 
takes you to the next data 
entry box in the dialog line. 
Press ENTER to accept the 
values. 
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9 Press ENTER to confirm. 

 

10 You can enter the next two lines in two ways: 
As these two lines are at right angles to the previous point, you 
can create them by entering values directly in the dialog line or 
using the track lines. 
First option: 
Draw the horizontal line by entering the length in the x-direction 
in the dialog line:  = -0.30 - ENTER. 
Draw the vertical line by entering the length in the y-direction in 
the dialog line:  = -4.00 - ENTER. 
 
Second option: 
Activate track tracing by clicking  Track line in the dialog 
line. 
Point to the end of the line you created last. Move the crosshairs 
slowly to the left. The 0.0-degree track line appears. 
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As soon as Allplan displays l = 0.300 for the offset, click this 
point or enter 0.3 m for the  Offset to reference point in the 
dialog line. Then press ENTER to confirm. 

 

Note: Track lines indicate the current length. This length is a 
multiple of the Grid length you can specify beside  Rasterize 
length in the dialog line. If you cannot define a specific length 
using the track lines, it is a good idea to change the Grid length. 

To draw the second line using track tracing, slowly move the 
crosshairs vertically downwards. The 90.0-degree track line 
appears. 
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As soon as Allplan displays l = 4.000 for the offset, click this 
point or enter 4 m for the  Offset to reference point in the 
dialog line. Then press ENTER to confirm. 

 

11 You can also use track tracing to place the next point.  
Point to point A and wait at least 500 milliseconds. The program 
creates a track point based on the point snapped.  

12 Now point to point B (= first point of the design). Wait there, too, 
until the program has created track points based on points A and 
B - this is indicated by a blue square. 
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13 Starting at point B, move the crosshairs vertically upwards as far 
as the point where the 90.0-degree track line and the 0.0-degree 
track line intersect. 
Click it. 

 

See also: 
 Track tracing is described in detail in the Allplan help. 

14 Switch track tracing off by deactivating  Track line in the 
dialog line. 

15 Finish creating the retaining wall by clicking the start point of 
the first line (point B). 

16 Press ESC twice to quit the Line tool. 
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Drainage 

To design the drainage 

1 Click  Circle in the Tools palette (Basic family - Draft module 
- Create area). 

2 The Circle Context toolbar opens. Click  Circle based on center 
and  Enter full circle. 

3 Point to the bottom left corner of the retaining wall. This point 
gets a red X. 

4  Delta point is active in the dialog line. Enter the following 
values: 

 dx = -0.5 
 dy = 0.5 

 

Press ENTER to confirm. 

 

This defines the center of the circle. 
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5 Enter a radius of 0.1 in the dialog line and press ENTER to 
confirm. 

6 Press ESC to quit the tool. 
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Task 2: hatching 

Now you will apply hatching to the retaining wall. You will also 
learn about the principles of entering polylines. The polyline entry 
tools are used by just about all functions that expect you to define 
polylines or polygonal-bounded areas (e.g. hatching, pattern, fill). 

Tools: Objective: 

 Hatching 

 

 Filter by Element 
Type 

  Area detection 

 Modify Format 
Properties  

 Hatching defaults 
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Applying hatching to the retaining wall 

To apply hatching to the retaining wall 

1 Click  Hatching in the Tools palette (Basic family - Draft 
module - Create area). 

2 On the Hatching Context toolbar, click Properties. 

 

3 Select hatching style 5 and set the parameters as shown below: 

• Line spacing area: 
Constant in layout, as set in defaults 

• Reference point area: 
Origin 
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4 Click OK to confirm the settings. 

5 Click Single in the input options. 

 

6 To define the area for hatching, click the corners of the retaining 
wall one after the other. 

 

7 To close the polyline, press ESC after you have clicked the last 
point or click the first point again. 

Tip: When you click Multi in 
the input options, you can 
enter as many areas as you 
want.  
After you have pressed ESC to 
finish entering the polyline, 
hatching is applied to these 
areas in a single step.  
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The selected hatching is applied to the retaining wall. 

 

8 Press ESC to quit the  Hatching tool. 
 

Copying the outline of the retaining wall 

Apart from clicking each corner of a polyline (as described above), 
you can enter polygonal-bounded areas in several ways. Using the 
retaining wall as an example, the following exercise will show you 
how to do this. 

You will start by copying the wall so that you have several copies 
for experimenting. To make sure that the hatching is not included in 
the copies, you will apply a filter. 
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To copy the outline of the retaining wall 

1 Right-click in the workspace and select  Copy on the shortcut 
menu. 

2 <Copy> Select the element(s) you want to copy 
In the Filter Assistant, click  Filter by Element Type, select 
Line and Circle/ellipse and click OK to confirm. 

 

Tip: You can also use the 
properties of the outline as a 
filter. Click  Match 
parameters from final 
graphics and then the 
outline. 
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3 <Copy> Select the element(s) you want to copy < =Line 
=Circle/ellipse > 
Enclose the retaining wall in a selection rectangle. 

 

 

As you have selected the Line and Circle/ellipse filters, only the 
outlines of the retaining wall and the drainage appear in the 
selection color. 

4 <Copy> From point  
Specify the starting point for the copy and place the retaining 
wall anywhere in the workspace. The position is irrelevant. 
However, make sure that the two retaining walls do not overlap. 

5 Press ESC to quit the  Copy tool. 

6 Click  Zoom All to display the two walls in their entirety on 
screen. 
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Applying hatching using area detection 

The next step is to apply hatching to the copy of the retaining wall. 
To do this, you will use a tool that automatically detects closed, 
delimited areas. 

To apply hatching using area detection 

1 Click  Hatching in the Tools palette (Basic family - Draft 
module - Create area). 

2 Hatching style 5 is still set on the Hatching Context toolbar.  
If it isn't, click Properties and select hatching style 5. Click OK to 
confirm. 

3 Click  Single in the input options. 

4 Select  Area detection in the input options. 

 

Note: You can only select  Area detection when Polygonize 
elements is active.  

 

5 Click a point within the retaining wall. 
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Allplan automatically detects the outline, polygonizing the entire 
retaining wall. 
As you have selected  Single in the input options, Allplan 
immediately applies the hatching. 

 

6 Press ESC to quit the  Hatching tool. 
 

Modifying hatching 

Next modify the hatching pen. 

To modify the hatching pen 

1 Click  Modify Format Properties (Edit toolbar). 

2 To change pen, open the Pen thickness list box and select pen 
number 7 with a thickness of 0.13 mm. 

This automatically selects the Pen thickness check box. 
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3 Click OK to confirm. 

Allplan prompts you to select the elements you want to draw 
with the new pen. Here, too, use a filter. 

4 Open the Filter Assistant, click  Filter by Element Type, select 
Hatching and click OK to confirm. 

5 Enclose the two retaining walls in a selection rectangle.  
As you have used a filter, Allplan only modifies the hatching. 

6 Press ESC to quit  Modify Format Properties. 
 

Tip: You can combine as 
many filters as you need. 
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Hatching defaults 

Allplan 2017 comes with a wide range of ready-made hatching 
styles. You can also define your own hatching styles or modify 
existing hatching styles. 

If you have worked your way through the exercises step by step, you 
set the paths for patterns and hatching styles to Project when you 
created the project for this tutorial. In other words, any changes you 
make to defaults (e.g. hatching, pattern) only affect the current 
project. 

If the path is set to Office, however, you run the risk of modifying 
the office standard. This means that any changes you make will 
affect all projects based on the office standard. 

To define or modify hatching styles 

1 Open the Tools menu and click Defaults. 

 

2 The Defaults dialog box opens. Select Hatching and click OK. 
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Note: If the You are modifying the hatching in the office path 
message appears, the settings you are about to make will modify 
the patterns and hatching styles in the office path. 

 

In this case, click Cancel and set the path to Project, which is 
described in the following section. 

3 Click the button beside Hatching number in the top part of the 
Hatching Definition dialog box. 
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4 Select a hatching number in order to modify it or select an 
unassigned number to define a new hatching style. 

 

5 Make settings in the Hatching Definition dialog box. 

Note: You can use the Pen and color defined in defaults are 
used for display option to specify whether you want to use the 
pen set on the Format toolbar or the pen defined in this dialog 
box. 

6 Click OK to confirm the dialog box. If you have changed the 
defaults, confirm the following prompt by clicking Yes. 
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The following section shows how to switch the path settings for 
patterns and hatching styles to project. You only need to do this 
when you see the You are modifying the hatching in the office 
path message after you have selected the hatching defaults. 

To switch the path settings for patterns and hatching 
styles to project 

1 Open the File menu and click  ProjectPilot. 

2 Open the Projects folder. 

3 Right-click the Basics Tutorial project and select Properties. 

4 Open the Settings tab and set the Path settings for Patterns, 
hatching styles, area styles to Project. 

 

5 Click OK to confirm. 
Allplan copies the office standard to this project. 

6 Close ProjectPilot by clicking Exit on the File menu. 
 

Tip: You can also access the 
path settings by clicking New 
Project, Open Project on the 
File menu. Open the shortcut 
menu of the Basics Tutorial 
project and click Properties.... 
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Polyline entry tools 

When working with Allplan 2017, you will find that the polyline 
entry tools considerably facilitate the process of identifying points 
and elements. They are used by countless Allplan tools where you 
need to define polylines or polygonal-bounded areas (e.g. fills, 
patterns, slabs, roof outlines ...). 

The polyline entry tools are integrated in the Input Options and 
open automatically when you select a tool for which they are 
available.  

 

Select the check box in the input options to activate the polyline 
entry tools. 
 

Input options for entering polylines, overview 

Whenever you select a tool that uses polyline entry tools (e.g. 
pattern, hatching, room), the Input Options appear. You can use 
these options to specify how the polyline entry tools behave when 
you generate polylines based on existing elements and how these 
tools are to handle architectural lines. 

 

Entering areas 

 Single 
Use this to create single, discrete areas. 

 Multi 
Use this to create areas composed of several polygons. Hatching, 
patterns or fills get the same group number; rooms are handled as a 
single entity. This way, you can define separate rooms, which 
Allplan then analyzes as a single room.  
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 Plus,  Minus 

If you select  Multi, you can use  Plus and  Minus in the 
input options to specify whether each new polygon you enter is to 
be added to or subtracted from the overall area. 

Polygonizing existing elements 

Polygonize elements on/off 
When the check box is not selected, Allplan ignores elements when 
you click them. In this mode, Allplan only detects points.  

When the check box is selected, Allplan polygonizes the elements 
you click. You can use the options next to this check box to specify 
the type of polygonization.  

 Polygonize entire element 
This uses the entire element that you clicked. The starting point 
defines the direction of polygonization. If the last point in the 
polyline coincides with the start or end point of the element, you do 
not need to specify the direction.  
Use this option when the outline consists of entire elements. 

 Define area of element to polygonize 
With this option, the program prompts you for the area with every 
element you click (from point, to point).  
Use this option when the outline consists of segments. 

 Enter reference point 
With this option, the program prompts you for the reference point 
with every element you click. This option uses a point on the 
element you clicked with a defined offset to the reference point. 
Click to define a new reference point and then enter the offset to the 
reference point. Use this option when you want to specify the outline 
based on existing elements (when you enter a dormer, for example). 
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 Area detection using additional point 

 Area detection using additional point combines areas bounded 
by lines and polylines to form a polygon. Allplan uses the inner 
boundaries or outer boundaries depending on whether the temporary 
point is inside or outside the outline.  
By selecting  Element filter, you can configure the program to 
ignore architectural lines when detecting areas. 

 Area detection 

You can use  Area detection to automatically detect the outlines 
of closed polygons. You can use closed areas delimited by design 
entities of any kind as an outline polygon simply by clicking 
anywhere within the area. Allplan automatically detects and 
polygonizes the entire outline. The boundary elements can have 
points in common; they can intersect and they can touch. You can 
turn this automation feature on and off at any time.  

Note: The Minimum distance between points setting in the  
 Options on the Desktop environment page also applies to the  
 Area detection tool. To make sure that Allplan detects outlines 

with small gaps, you can temporarily increase the minimum distance 
between points. 

 Island detection,  Inverse island detection 

When  Island detection is on, Allplan detects closed outlines 
within an area and cuts them out automatically.  
When you select  Inverse island detection, Allplan does nor cut 
out closed outlines. Instead, Allplan fills these outlines with the 
selected surface element. It is the area around the 'island' that 
remains empty.  

You can only use these tools together with  Area detection using 
additional point and  Area detection.  
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Number of segments / Rise 

 Number of segments 
The polygonization value is interpreted as the number of segments. 
The value for  Number of segments defines the number of 
segments used to approximate a curve. In the case of a circle, for 
example, a value of 120 means that a full circle is approximated by 
a 120-sided polygon. The higher the degree of accuracy you require 
or the larger the radius, the higher the number of segments should be 
used to approximate a circle. You can enter a value between 36 and 
360. 

  

(A) Segments in circle = 36; this will produce an angle of 10°  

 Rise 
The polygonization value is interpreted as the rise. The value you 
enter for  Rise defines the maximum rise of the secant relative to 
the arc (in mm). As a result, the curve is polygonized so that the 
maximum offset of the polyline's segment to the curve is less than or 
equal to the value your specified. This setting produces more 
accurate results than the number of segments. 

  

(B)  Rise (38mm or less)  
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Element filter 

 Element filter 
Ignore plan lines of architectural elements 
Ignore 2D surface elements (hatching, patterns, fills, bitmap areas, 
smart fit placements) 
when using area detection  

When you select the  Element filter, Allplan ignores lines of 
architectural elements and 2D surface elements in conjunction with 

 Area detection or  Area detection using additional point. Use 
this option if you want to automatically apply surface elements like 
hatching, patterns and so on to adjacent outlines that are separated 
by arcs, splines or curves. 

Here is some background information: Allplan polygonizes curves 
based on the number of segments specified. 
If you enter a second (third...) area, Area detection may take a long 
time or produce incorrect results because Allplan detects both the 
outline of the surface (2D line) and the boundary line of the polyline 
of the first area. 

Back, Help 

 Back  
This undoes the last point you entered. 

 Help for entering polylines  
This displays help for the polyline entry tools. 
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Additional tools in the dialog line 

The dialog line offers the following drawing aids for entering points: 

 

Icon Function Use 

 Enter at right 
angles 

The line can only be drawn at 
right angles to the current system 
angle. 

 Enter using 
cursor snap 

The line can only be drawn at 
specific angles. 

 Cursor snap Define the cursor snap angle 
here. The current angle is 
displayed. 

Note: While you are entering a polyline, it can happen that you 
inadvertently click a point. You can use  Back in the input 
options to undo every point entered in reverse order.  
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Exercise 3: Purlin Roof 
In this exercise you will design a purlin roof. In addition, you will 
label the roof and apply leaders. 

 

You will use the tools in the  Draft and  Text modules in the 
Basic family. 
 

Task 1: designing a purlin roof 

You will familiarize yourself with the Intersect 2 Entities, Polar 
Coordinates and Division Point tools.  

Tools that were covered earlier in previous exercises (e.g. rectangle, 
parallel lines, brackets) are not described in detail in this exercise. 
 

Tools: Objective: 

 Intersect 2 Entities 

 

 Division Point  

 Track Line 
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Slab and rafters 

The first part of this exercise involves designing the slab, the roof 
beams and the rafters. You will draw the slab as a rectangle and 
create the rafters as lines and parallel lines. First you will design the 
rafter on the left-hand side and then copy it to the right-hand side. 

To draw the slab and the rafters 

1 Click  Open on a Project-Specific Basis and open an empty 
drawing file. Name it Purlin roof and close all the other drawing 
files. 

2 Click  Rectangle in the Tools palette (Basic family - Draft 
module - Create area). In the input options, select  Based on 
diagonal line. 

3 Draw the concrete slab as a rectangle. 
 X coordinate = 5.74 (length),  Y coordinate = 0.22 (width) 

 

4 The  Rectangle tool is still active. Click the top left corner of 
the concrete slab and create a roof beam: 

 = 0.12 and  = 0.12 

 

5 Click  Line in the Tools palette (Basic family - Draft module - 
Create area). 

6 Click  Individual lines on the Line Context toolbar and specify 
where you want the line to start by clicking the top left corner of 
the beam (see below).  
You will create the roof overhang later. 

7 The roof pitch is 30°.  
To draw a line at this angle, click  Enter using cursor snap. 

8 Enter 30 to define the angle.  
Now you can only draw the line at an angle of 30° (and in steps 
incremented by 30°). 
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9 Draw the line as shown below and place its end point by clicking 
the left mouse button. For the time being, the length of the line is 
not important. If necessary, you will delete redundant segments 
later. 

 

10 The rafter is to rest on the roof beam. Click  Parallel Lines in 
the Tools palette (Basic family - Draft module - Create area) and 
create the bottom edge of the rafter. Enter 0.03 for the offset. 
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11 The  Parallel Lines tool is still active. To create the top edge of 
the rafter, enter -0.14 for the offset (opposite direction!) and 
press ESC to quit the tool. 

 

12 Right-click the line in the middle and select Delete on the 
shortcut menu to remove the reference line. 

 

13 The next step is to create the vertical end of the rafter. 
Click  Parallel Lines again. To define the reference element, 
click the left edge of the slab and enter 0.30 for the offset (= roof 
overhang). 

 



 

100 Exercise 3: Purlin Roof Allplan 2017  

14 Now lengthen the top and bottom edges of the rafter as far as the 
point where they intersect the vertical edge. To do this, use the 

 Intersect 2 Entities tool. 

Right-click the top edge of the rafter and select  Intersect 2 
Entities on the shortcut menu. 

15 To define the second element, click the vertical edge of the rafter. 

16 Click the bottom edge of the rafter and then the vertical edge. 

 

Allplan intersects the lines. Next you will delete the redundant 
line segments. 

17 Right-click one of the lines you want to delete and select  

 Auto-Delete Segment on the shortcut menu. Click the 
protruding line segments. 

 

The rafter on the left is complete. You will mirror this rafter 
across a vertical line which passes through the middle of the roof 
beam, thus producing the rafter on the right. 
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18 Use the left mouse button to enclose the rafter on the left and the 
roof beam on the left in a selection rectangle from bottom left to 
top right (positive x-direction).  

 

19 Point to a line of the rafter and click  Copy and Mirror on the 
context toolbar. 

 

20 Now it is a good idea to select track tracing as it helps you enter 
the mirror axis. 
Press the F11 key to activate track tracing. 

21 Place point 1 for mirror axis: the first point of the mirror axis is 
the center of the beam. Select  Midpoint on the shortcut menu 
and click the top edge of the beam. 
A red cross indicates the center of the beam. Click it. 

2nd point of mirror axis: using track tracing, you can display the 
track line that is perpendicular to the first point of the mirror axis 
(= midpoint of the top edge of the beam). Move the crosshairs 
roughly at a 90-degree angle above or below the first point of the 



 

102 Exercise 3: Purlin Roof Allplan 2017  

mirror axis. The 90-degree track line appears. Click this line 
wherever you want.  
Allplan creates a vertical mirror axis, mirroring and copying the 
selected elements. 

 

22 Press ESC to finish. 

23 To delete the protruding line segments, click  Auto-Delete 
Segment in the Tools palette (Basic family - Draft module - 
Change area). 

24 Click the protruding line segments. The result might look like 
this: 

 

25 To draw the line between the two rafters, click  Line and select 
 Individual lines. 
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26 Draw a vertical line as shown below. 

 

27 Press ESC to quit the  Line tool. 
 

Ridge purlin and collar beam 

In the next exercise, you will draw the ridge purlin, the center purlin 
and the collar beam. First draw the ridge purlin as a rectangle. Then 
create the collar beam and the center purlin by intersecting two 
elements and drawing a parallel line. 

To draw the ridge purlin and the collar beam 

1 Click  Rectangle in the Tools palette (Basic family - Draft 
module - Create area) and select Based on center line on the 
Rectangle Context toolbar. 

 

2 Start point: click the bottom point where the two rafters intersect. 
End point: click  Delta point in the dialog line and enter the 
following value for the y direction: -0.16. 
Point or half the width: enter half the width of the ridge purlin: 
0.05. 
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3 Use the elements of the ridge purlin to create the center purlin 
and the collar beam. 

4 Draw the bottom edge of the collar beam based on the bottom 
edge of the ridge purlin. Click  Parallel Lines and enter 0.12 
for the offset. 

 

5 Click  Intersect 2 Entities. 

6 First click the bottom edge of the ridge purlin and then the outer 
edge of the rafter on the right. 

7  Intersect 2 Entities is still active. Now make the bottom edge 
of the ridge purlin intersect the outer edge of the rafter on the 
left. 

 

8 Using the same approach, make the bottom edge of the collar 
beam intersect the outer edges of the two rafters. 
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9 Use track tracing to join the two vertical edges of the ridge purlin 
with the top edge of the slab. 
Select the  Line tool and click  Individual lines.  

10 Point to the vertical, right-hand edge of the ridge purlin and then 
move the crosshairs in a vertical direction. 

The 90-degree track line appears. Move the crosshairs along this 
track line until Allplan displays the point of intersection with the 
collar beam. Click this point. 

 

11 Follow the track line as far as the point of intersection with the 
top edge of the slab and click this point. 

 

12 Repeat steps 10 and 11 for the left edge of the ridge purlin. 
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13 Use  Auto-Delete Segment to delete the redundant line 
segments. 
The design should now look like this: 

 

14 Press ESC to quit the  Auto-Delete Segment tool. 
 

Construction lines 

You will use six nails to fasten each rafter to the collar beam. First, 
create a grid consisting of lines in construction line format. To do 
this, use the Division point function provided on the shortcut menu 
when a tool is active (e.g. Line). This grid will help you place the 
nails later. You can use the Division point function to address 
division points of lines or other design entities. The nails will be 
placed on the points where the grid lines intersect. 

To draw horizontal construction lines 

1 Draw the grid lines as construction lines.  
To switch to construction line mode, click  Construction Line 
on/off (Format toolbar). 

2 Click  Line in the Tools palette (Basic family - Draft module - 
Create area). 
Click  Individual lines on the Line Context toolbar.  

3 To specify where the line is to start, click  Division point on 
the shortcut menu. 

Tip: The color and line type of 
the construction lines are 
based on the settings you 
have made in the Options - 
Desktop environment - 
Display page. 
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4 Click the endpoints of the line to be divided. 

 
A = Start point 
B = End point 

5 Click division point: enter the number of divisions in the dialog 
line: n = 6. 

 

Allplan temporarily displays the division points on screen. 

6 To specify the division point where the line is to begin, enter its 
number (1) in the dialog line and press ENTER to confirm. 
Allplan starts to count at point A (= the start point of the line 
you divided). 
You can also define the division point by clicking it. 

Tip: You can also address 
division points located on the 
extension of the division line 
by entering -1, -2, and so on. 
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7 To point: as the line is horizontal, you can use the track line 0.0 
to specify the end of the line. 
The length of the line is not important. However, make sure that 
it projects beyond the right edge of the rafter. 

 

 
A = Division point 1 
B = Track line 0.0 

8 Press ESC to quit the  Line tool. 

9 Now create four equidistant copies of the construction line and 
place them above the first one. 
Click the construction line and select the  Copy tool on the 
context toolbar. 
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10 From point or enter offset: 
Click the point where the outer edge of the rafter and the bottom 
edge of the collar beam intersect (see below). 

 

11 To point or enter offset: 
Enter the  Number of copies in the coordinate dialog box: 4. 

12 Click the point where the outer edge of the rafter and the 
construction line intersect (see below). 

 

13 Press ESC to quit the  Copy tool. 
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Now use Division point again to draw the sloping construction lines. 
To specify the direction of the construction line, use Polar 
coordinates. 

To draw sloping construction lines 

  Construction Line mode is still active. 

1 Click  Line in the Tools palette (Basic family - Draft module - 
Create area). 

2 Click  Individual lines on the Line Context toolbar. 

3 Specify where the sloping construction line is to start: 

• a) Click  Division point (shortcut menu). 

• b) Click the end points of the line (see below). 

• c) Enter 5 for the number of divisions. 

• d) Click division point 1. 

 

This defines the start point of the sloping construction line. 

 
A = Start point 
B = End point 
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4 The construction line needs to be parallel to the rafter. Open the 
shortcut menu with the right mouse button and select  Track 
tracing options. 
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5 The Options dialog box opens. Set the Cursor snap angle to 30°. 

 

6 Click OK to close the Options dialog box. 

7 Move the crosshairs along the track line 30.0. Use the mouse to 
specify the length of the construction line.  
The exact length is not important. However, make sure that the 
line projects beyond the horizontal line at the top. 
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8 Press ESC to quit the  Line tool. 

9 Create three copies of the construction line and place them to the 
right: 

• a) Click the construction line and select the  Copy tool on 
the context toolbar. 

 

• b) From point or enter offset: click the point where the outer 
edge of the rafter and the bottom edge of the collar beam 
intersect (see below). 

• c) To point or enter offset: enter the  Number of copies in 
the coordinate dialog box: 3. 

• d) Click the point where the outer edge of the rafter and the 
sloping construction line intersect (see below). 

 

Now you have created the temporary grid which helps you place 
the nails. 

10 Press ESC to quit the  Copy tool. 

11 Click  Construction Line on/off (Format toolbar) to switch 
construction line mode off again. 
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Nails 

You will place the nails based on the temporary grid consisting of 
construction lines. First draw a nail as a circle. Then copy this circle 
to the points where the construction lines intersect. Finally, mirror 
and copy the complete design onto the opposite side. 

To place nails 

1 To draw a nail as a circle, click  Circle in the Tools palette 
(Basic family, Draft module, Create area).  
The Circle dialog box opens. Select  Circle based on center 
and  Enter full circle. 

2 To define the center of the circle, click the point where the 
horizontal construction line at the bottom and the vertical 
construction line on the left intersect. 

3 Enter the radius in the dialog line: 0.01 

 

Tip: Before placing the copies 
of the circle, check that you 
have activated the Point of 
intersection option in the 
Point snap area of the  

 Point snap options 
(shortcut menu). Allplan does 
not emit an acoustic signal 
when you place the copies of 
the circle. 
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4 To create the other nails, click  Copy and select the circle. 
From point 
Select the center of the circle as the reference point. 
To point 
Copy the circle to the points where the construction lines 
intersect (as shown below). 

 

5 Delete the temporary grid consisting of construction lines. To do 
this, you will use an element filter. Right-click in the workspace 
and select Delete on the shortcut menu. 

6 Click  Filter by Construction Line Format on the Filter 
Assistant toolbar. 

7 Select the condition (=) in the dialog box and click OK to 
confirm. 

 

8 Use the left mouse button to enclose the temporary grid in a 
selection rectangle. 
As you have applied a filter, only the construction lines are 
deleted (and not the nails). 

9 Press ESC to quit the  Delete tool. 
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To finish, you will mirror the nails onto the rafter on the right. 

To mirror the nails 

1 Use the left mouse button to enclose all nails in a selection 
rectangle. 

2 Point to a circle.  
Make sure that you do not point to a handle! 

 

3 Click  Copy and Mirror on the context toolbar.  

4 To obtain a mirror axis that is exactly vertical: 

• a) Click the gable peak. 

• b) Move the crosshairs vertically downwards so that the track 
line 90.0 appears. 

• c) Use the left mouse button to click in the workspace below 
the design. 

Tip: Instead of defining the 
vertical mirror axis using the 
90.0-degree track line, you 
can click the vertical line 
between the rafters. 
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5 Press ESC. 

The design should now look like this: 
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Task 2: labeling the purlin roof 

Now you will label the purlin roof.  
 

Tools: Objective: 

 Horizontal 
Text 

 

  

  

  

 
 

Labeling 

To label the purlin roof 

1 In the Tools palette, select the  Text module (Basic family). 

2 Click  Horizontal Text (Create area) and specify where the text 
is to start by clicking in the workspace (see below). You can enter 
text and set parameters for it in the dialog box which appears. 
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See also: you can find detailed information on entering and 
editing text in the help for Allplan. 

3 You do not need the track tracing feature to create labels. Switch 
it off by pressing the F11 key. 

4 Set the text height to 2.0 mm: click in the Text height box and 
enter 2.0. The text width changes dynamically with the aspect 
ratio set. 

5 Open the Load Font pulldown menu and select front number 8 
Isonorm DIN 6776. 

6 To specify where the text is to start, click to set the  Text's 
Anchor Point to bottom left and disable the Paragraph Text 
option. 

 

7 Type Ridge purlin 10/16 for the text and click OK to confirm. 

The text is placed in the workspace.  
The  Horizontal Text tool is still active. 

 

Tip: To place text, you can 
also press CTRL+ENTER 
instead of clicking OK. 

Tip: You can change the 
drop-in point by clicking 
anywhere in the workspace 
until you place the text. 
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8 Click in the workspace to specify where the next line of text is to 
start and label the drawing as shown at the beginning of this 
exercise. 

9 When you have entered all the labels, press ESC to finish entering 
text and to quit the  Horizontal Text tool. 

 

Creating leaders 

Leaders connect text with design entities. Leaders are always placed 
at a defined offset to the text and Allplan creates them as lines using 
the pen you have currently selected. You can also apply symbols to 
the start points and/or end points of these lines. 
A leader always starts at a defined point of the text. Every text has 
eight points from which the leader can originate: 

 

When you move text, the leader ”sticks" to the starting point you 
have defined. 

To create leaders 

 The Text module is still open. 

1 To attach a leader, click  Leader (Create area). 

2 On the Text leader Context toolbar, click  Individual lines. 

3 Select the End symbol option and choose Black steel 
construction arrow without boundaries on the dropdown menu. 

4 The Symbol height is set to 3.00 mm. Leave this setting as it is. 

 

Tip: If you have accidentally 
created a leader at the wrong 
position, you can easily 
correct this: click  Back on 
the Text leader Context 
toolbar and place the leader 
again. 



 

Basics Tutorial Unit 2: Designing and Modifying 2D Elements 121 
 

5 Leader to text: click the text to which you want to attach a 
leader. Make sure that you click the point where you want the 
leader to begin (at bottom left). 
The text is displayed in the selection color. 

6 To point: click where the leader is to end. 

 

The  Leader tool is still active. To attach a leader to the next 
line of text, repeat steps 4 and 5. Attach leaders to the other 
labels as shown below. 

 

7 Press ESC to quit the  Leader tool. 
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Exercise 4: Rotary with Three Roads 
In this exercise you will design a rotary with three roads leading up 
to it. 

 

You will use the tools in the  Draft module in the Basic family. 
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Task 1: designing a rotary with one road 

In the first part of this exercise you will design a rotary with one 
road leading up to it. There is a traffic island in the middle of the 
road. You will start by drawing a rough outline consisting of a circle, 
lines and parallel lines. You will learn about the Circle and Fillet 
tools. The final outline will be created using the Fillet tool  
 

Tools: Objective: 

 Circle 

 

 Parallel Lines 

 Polar 
coordinates 

 Auto-Delete 
Segment 

 Fillet 
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Rotary with one road 

In the first part of this exercise you will design the rotary and one of 
the three roads leading up to it.  

To draw the rotary 

1 Click  Open on a Project-Specific Basis and open an empty 
drawing file. Name it Rotary and close all the other drawing files. 

2 Click  Circle in the Tools palette (Basic family - Draft module 
- Create area). 

3 The Circle Context toolbar opens. Click  Circle based on center 
and  Enter full circle. 

 

4 Click in the workspace to define the center of the circle. 

5 To specify the Radius, enter 12.25 m in the dialog line.  

6 Press ENTER to confirm. 

7 Switch to the  Parallel Lines tool. 

8 Click the circle. 

9 Enter 5.25 m for the Offset and press ENTER to confirm. 

10 Click within the circle to specify the side on which the parallel 
line is to be created. 

11 Enter 1 for the Number and press ENTER to confirm. 

This will result in a lane width of 5.25 m in the rotary. 
 

Next draw the first road as a line. As the road is to be created at a 
given angle, you will use polar coordinates.  

To design the first road 

1 Click  Line in the Tools palette (Basic family - Draft module - 
Create area) to draw the top edge of the road opening. 

2 Click  Individual lines on the Line Context toolbar. 

3 Click within the rotary to specify where you want the line to start 
(as shown below). 
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4 To draw the road at a given angle, click  Polar coordinates in 
the dialog line. 
<Line> To point  
The angle between the opening and the path is 5°. Positive angles 
are measured in a counter-clockwise direction. Enter 355.  
Press the TAB key and enter 25 for the length. 
Press ENTER to confirm. 

 

5 Click  Parallel Lines in the Tools palette (Basic family - Draft 
module - Create area) to draw the bottom edge of the road. 
The  Line tool closes automatically. 

6 Click the line you just created. Enter the following values in the 
dialog line: 
Offset:  6.00 
Which side? Click below the line. 
Number:  1  
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7 You can now delete the redundant line segments protruding into 
the rotary. 
Right-click a line you want to delete. 

8 Choose  Auto-Delete Segment on the shortcut menu and click 
the line segments you want to delete. 
Allplan deletes the lines as far as the point where they intersect 
the rotary. 

 

9 Press ESC to quit the  Auto-Delete Segment tool. 
 

Traffic island for road 

Next you will design the traffic island, which consists of lines 
parallel to the road you just created. You will then use lines to 
connect the parallel lines.  

To design the traffic island 

1 Click  Parallel Lines in the Tools palette (Basic family - Draft 
module - Create area). 

2 Click the bottom line of the road to use it as the reference 
element for the traffic island (see illustration below). 

3 Enter 2.50 for the offset to create the bottom edge of the traffic 
island. 

Tip: You can also select the 
 Auto-Delete Segment 

tool in the Tools palette 
(Basic family - Draft module 
- Change area). 
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4 Click above the reference element to indicate the side and enter 
the Number in the dialog line: 1. 
This creates the first parallel line; the  Parallel Lines tool is 
still active. 

5 The system prompts you to enter an offset in the dialog line. The 
value you enter is based on the parallel line you just created. 
Enter the offset between the bottom and top of the traffic island: 
1.00 

 

6 Click  Line in the Tools palette (Basic family - Draft module - 
Create area). The  Parallel Lines tool closes automatically. 
Make sure  Individual lines is selected on the Line Context 
toolbar. 

7 Choose  Delta Point in the dialog line.  



 

128 Exercise 4: Rotary with Three Roads Allplan 2017  

8 Join the end points of the two parallel lines (see below) and press 
ESC to quit the tool. 

 

You will use this line as the reference line. 

9 Click  Parallel Lines in the Tools palette (Basic family - Draft 
module - Create area). 

10 Click the line you just created to use it as the reference element. 
The system prompts you to make entries in the dialog line. Enter 
the following values: 

• Offset:  5.00; Which side?  To the right;  Number: 2 

• Press ESC to quit the tool. 

11 Right-click a line of which you want to delete redundant 
segments. 
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12 Choose  Auto-Delete Segment on the shortcut menu and click 
the line segments you want to delete (see below). 

 

13 Press ESC to quit the  Auto-Delete Segment tool. 
The result might look like this: 
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Filleting the road and traffic island 

In the next exercise you will create the final outline of the road and 
the traffic island. To do this, you will use the Fillet tool, which 
allows you to apply a fillet to corners and to join lines, which do not 
touch, with arcs. After you have clicked the two elements, Allplan 
will present auxiliary circles for you to choose from. 

To fillet the road and the traffic island 

1 Click  Fillet in the Tools palette (Basic family - Draft module - 
Change area). 

2 You will start with the traffic island. Click its top and bottom 
lines. 
The fillet radius is set to 0.5. Press ENTER to confirm it. 
Two auxiliary circles appear on screen. 

3 Click the circle you want to use for the fillet. 

 

4 Repeat steps 2 and 3 for the opposite side of the traffic island. If 
you can’t see the result, click  Refresh (View menu) to refresh 
the screen contents. 

5  Fillet is still active. Trimming is displayed in the input 
options. When this button is activated (default setting), the 
elements are shortened or lengthened automatically. If it isn't 
active, click to select it. 
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The traffic island is created. Now you will apply a fillet to the 
road leading up to the rotary. 

6 Click the top edge of the road and the adjoining outer arc to 
create the fillet at the top (see below). 

7 Enter the radius: 12.00 

8 Click the circle you want to use for the fillet. 

 

9 Click the bottom edge of the road and the adjoining outer arc to 
create the fillet at the bottom (see below). Repeat steps 7 and 8. 
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10 If necessary, use  Auto-Delete Segment to delete redundant 
segments. The following should now be displayed on your screen: 

 

11 Press ESC to quit the  Auto-Delete Segment tool. 
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Task 2: pattern 

In this task, you will apply a pattern to the road leading up to the 
rotary. You will learn about the Pattern and Pattern definition tools. 
 

Tools: Objective: 

 Pattern 

 

 Pattern 
definition 

 Area detection 

 Island 
detection 

 Select Pattern 

 Pattern Width 

 Pattern Height 

 Modify Format 
Properties 

 Convert 
Surface 
Element 

  

  

  

 
 



 

134 Exercise 4: Rotary with Three Roads Allplan 2017  

Creating closed outlines 

The first step involves creating closed outlines. This is necessary if 
you want to use Area detection to apply patterns to the rotary and 
the road afterwards.  

To create a closed outline for the road 

1 To do this, you will use construction lines. 
Select the  Construction Line tool on the Format toolbar. 

 

Note: Construction lines are like erasable pencil lines on 
conventional drawings. When you select construction line mode, 
new elements are drawn using the construction line color and 
line type set in the  Options - Desktop environment - Display 
page - Drawing file and NDW window area. Elements drawn as 
construction lines are excluded from printouts. 

2 Click  Circle in the Tools palette (Basic family - Draft module 
- Create area). 

3 The Circle Context toolbar opens. Click  Circle based on center 
and  Enter full circle. 

4 Click the existing center of the inner circle. 

5 To specify the Radius, enter 12.25 m in the dialog line.  

6 Press ENTER to confirm. 

7 Switch to the  Line tool (Basic family - Draft module - Create 
area) to join the right-hand ends of the two lines representing the 
boundaries of the road. The  Circle tool closes automatically. 
Make sure  Individual lines is selected on the Line Context 
toolbar. 

8 Choose  Delta Point in the dialog line.  
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9 Join the end points of the two parallel lines (see below) and press 
ESC to quit the tool. 

10 Switch construction line mode off again. 

Your drawing should now look like this: 
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Applying a pattern to the road 

Next, you will apply a pattern to the road leading up to the rotary. 
You will use area detection to define the area which is to be given a 
pattern. The traffic island is to be left out. 

To apply a pattern to the road 

1 Click  Pattern in the Tools palette (Basic family - Draft 
module - Create area). 

2 Click  Single in the Input Options. 

 

3 On the Pattern Context toolbar, click Properties. 

4 Select pattern 8 and set the following parameters: 

• Reference point area: 
Origin 

• Resize height, width area: 
Adjust to scale in layout 

• Size area: 
Height factor and width factor: 1.00 

• Placement type area: 
Trim along boundary 
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5 Check that the Polygonize element check box is selected in the 
input options. 

6 Select  Area detection and  Island detection in the input 
options. 

 Island detection detects closed outlines within an area and 
cuts them out automatically. 
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7 Click within the closed outline of the road with the left mouse 
button. 
Make sure that you do not click within the part you want to cut 
out. 

 

The outline of the road is detected as a closed area and the traffic 
island is cut out automatically. You should hear an acoustic 
signal. 

 

8 Press ESC to quit the  Pattern tool. 
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Applying a pattern to the rotary 

The next step is to apply two different patterns to the rotary. The 
procedure is basically the same as the one described in the previous 
step.  

To apply a pattern to the rotary 

1 Before you apply patterns to the areas, delete the arc that is 
directly under the circle you created as a construction line. 
Select the  Delete tool (Edit toolbar). 

2 Point to the outer circle of the rotary. Make sure that you do not 
select the part of the circle that belongs to the road. The arc is 
displayed in the selection preview color. Click it. 

 

3 Convert the circle you created as a construction line to a design 
entity. 
Select the  Modify Format Properties tool (Edit toolbar). 

4 Select Convert construction lines to 2D entities and click OK. 
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5 Click the circle and press ESC. 

6 Click  Pattern in the Tools palette (Basic family - Draft 
module - Create area). 

7 Click  Single in the Input Options. 

 

8 Click Properties on the Pattern Context toolbar. 

9 Select pattern 114, enter 10 for the Height factor and the Width 
factor and set the following parameters: 

• Reference point area: 
Origin 

• Resize height, width area: 
Adjust to scale in layout 

• Placement type area: 
Trim along boundary 
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10 The pattern is to have a background color.  
Select the Background color option and click in the box to select 
a color. 

 

11 Click the Color name button and select Default Allplan Color 25. 
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12 Close the Select RGB Color and Pattern dialog boxes by clicking 
OK. 

13 Check the input options to see if the Polygonize elements on/off 
check box is selected and  Area detection and  Island 
detection are switched on. 

 

14 Click the outer circle with the left mouse button. 

15 Press ESC again to quit the  Pattern tool. 
 

Apply pattern 105 to the inner circle yourself. Enter 10 for the 
Height factor and the Width factor. Select Allplan Default Color 78 
for the background color.  
The result should look like this: 
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Applying a pattern to the traffic island 

Finally, you will apply a pattern to the traffic island of the road. You 
will use the same pattern as for the inner circle of the rotary. 

To apply a pattern to the traffic island 

1 Click  Pattern in the Tools palette (Basic family - Draft 
module - Create area). 

2 To match a pattern you have already applied, click  Match 
parameters on the Pattern Context toolbar. 

3 Click the pattern in the inner circle of the rotary. 

4 Click  Single in the input options. 

5 Check that  Area detection is selected in the input options. 

6 Zoom in on the area around the traffic island. 

7 Click within the traffic island. 

The pattern is applied to the traffic island. 
 

The result should now look like this: 

 



 

144 Exercise 4: Rotary with Three Roads Allplan 2017  

Defining a new pattern 

Allplan 2017 comes with various ready-made patterns (depending on 
the configuration). You can also modify existing patterns and define 
new ones. In the following exercise you will learn how to define a 
new pattern and apply it to the road. 

 

Please read the notes on defining hatching styles. They also apply to 
patterns. 
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To define a new pattern 

1 Open the Tools menu and click Defaults. 

 

2 On the context toolbar, click Pattern. 

 

Begin by selecting an unassigned pattern. 
 

3 Click  Select Pattern in the Tools palette (Basic family - 
Pattern Editor module - Change area). 

 

Tip: The patterns that are 
already defined depend on 
the configuration you have 
purchased. Patterns 10 and 
higher are usually free.  
When you select a free 
pattern, only the editing 
frame and the temporary 
crosses are displayed on 
screen. 
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4 Select a free number (e.g. 11) in the Select Pattern dialog box. 

Allplan displays an editing frame on screen, making i easier for 
you to define patterns. The frame contains a grid of dots to help 
you draw the pattern. 

 

 

5 Click  Pattern Width in the Tools palette (Basic family - 
Pattern editor module - Change area) and enter the width of the 
pattern in mm in the dialog line: 200. Press ENTER to confirm. 

6 Click  Pattern Height in the Tools palette (Basic family - 
Pattern editor - Change area) and enter the height of the pattern 
in mm in the dialog line: 200. Press ENTER to confirm. 
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7 Click  Line in the Tools palette (Basic family - Pattern editor - 
Create area).  
Click  Polyline on the Line Context toolbar. 
Draw the pattern as shown below. 

 

8 Press ESC three times to quit the  Line tool and to finish 
defining the pattern. 

9 Click Yes when you see the following prompt: Would you like to 
save the pattern definition? 
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Applying the new pattern 

The pattern is defined. Now you will apply the new pattern to the 
road. You need to make some settings in the Pattern dialog box to 
adjust the pattern to the road. 

To apply the new pattern 

1 Click  Convert Surface Element in the Tools palette (Basic 
family - Draft module - Change area). 

2 On the context toolbar, select Modify, Convert Pattern to 
Pattern and click Properties. 

 

The Pattern dialog box opens. 

3 Select pattern 11 and enter 5 for the Width factor and Height 
factor in the Size area and set the following parameters: 

• Reference point area: 
Origin 

• Resize height, width area: 
Adjust to scale in layout 

• Placement type area: 
Trim along boundary 
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The pattern is to be placed at an angle of 5°. You can copy the 
angle directly from the drawing. 

4 In the Direction, color area, click  beside Angle.  
The dialog box closes and your design is displayed. 

5 Click the top line of the road.  
The dialog box opens again and an angle of -5° is displayed. 

6 Here, the pattern is to be generated from the point at bottom 
right; i.e. this is the reference point. Click Custom point in the 
Reference point area to define the reference point. 
The dialog box closes temporarily. 

7 Click the point at bottom right to define it as the reference point. 

8 Click OK to confirm the settings. 

Tip: The pattern is generated 
from a reference point. 
To define a new reference 
point, set the reference point 
to Origin and then to Custom 
point. 



 

150 Exercise 4: Rotary with Three Roads Allplan 2017  

9 Click the pattern to be modified. The pattern changes depending 
on the settings you have made. 

10 Press ESC to quit the tool. 
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Task 3: completing the design 

In this task, you will add the two missing roads to the rotary. You 
will learn about the Copy and Rotate tool. 
 

Tools: Objective: 

  Copy and 
Rotate 

 

 Pattern 
Line 
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Creating the missing roads 

You will complete the rotary, so that three roads lead up to it. 

To add two more roads 

1 Use the left mouse button to enclose the entire road in a selection 
rectangle (from bottom left to top right: positive x-direction). 

 

The road, pattern and traffic island are displayed in the selection 
color. In addition, handles appear. 

2 Point to the upper boundary line of the road. Make sure that you 
do not point to a handle!  

Tip: Elements can be selected 
by enclosing them in a 
selection rectangle.  Select 
elements based on direction 
(Filter Assistant toolbar) is 
the default setting: when you 
open the selection rectangle 
in the positive x-direction, 
only the elements that are 
fully bounded by the 
selection window are 
selected; when you enter the 
selection rectangle in the 
negative x-direction, all the 
elements that are fully or 
partially bounded by the 
selection window are 
selected. 
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3 Click  Copy and Rotate on the context toolbar. 

 

 

4 Click base point of rotation 
Click the center of the rotary. 

5 Select Rotate in the input options to rotate the elements at the 
same time, 

6 How many times? 
Enter  3 in the coordinate dialog box and press ENTER to 
confirm. 
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7 Start point, reference line or rotation angle 
Enter 120° for the angle of rotation in the coordinate dialog box 
and press ENTER to confirm. 
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8 Press ESC to quit the tool. 

 

You can now adjust the pattern placed in the two new roads to 
the angle of the other road (compare the section "Applying the 
new pattern (on page 147)"). 
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Pattern line 

Finally, you will add a row of large paving stones to the edge of the 
inner circle of the rotary. To do this, you will use the Pattern Line 
tool.  

To add a pattern line 

1 Zoom in on the inner circle of the rotary.  

2 Point to the inner circle.  
Pay attention to element info: check that Circle is displayed. 
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3 Double-click the inner circle with the left mouse button.  

The circle is displayed in the selection color. The Properties 
palette opens. You can see the properties of the selected circle. 

4 Select the Pattern line option in the Properties palette. 
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5 The pattern line properties are highlighted in yellow. 
Open the list of patterns and select pattern 4. 
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6 Adjust the Height and Width of the pattern. Select 0.20 m for 
both values. 

7 Position relative to reference line: select left. 

 

8 Press ESC. 
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Exercise 5: Title Block 
In this exercise, you will create a title block and enter text for it. 

 

You will use the  Draft and  Text modules in the Basic family. 

Note: In addition to the method described in this exercise, Allplan 
offers additional options for creating and labeling title blocks: 
The  Layout module provides the  Label tool, where you can 
select from various title blocks. These title blocks, which are saved as 
label styles, transfer specific details and project attributes (date, 
project name, edited by and so on) straight from the system to the 
title block. The Architecture Tutorial (unit 8) includes an example 
showing how to create a title block as a label style. 
 

In addition, you can use the  Legend, Title Block tool. These 
legends always include the current layout attributes and project 
attributes. The program always creates the legends as associative 
legends to make sure that changes in the attributes update 
automatically. After having placed a legend, you can resolve it into 
its design entities. 
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Task 1: designing the title block 

In the first part of the exercise that follows you will draw the layout 
of the title block with tools in the  Draft module (Tools palette - 
Basic family). 

Tools Objective 

 Reference Scale 

 

 Rectangle 

 Parallel Lines 

 Auto-Delete Segment 

 Delete 

 Modify Format Properties 

Each module has its own set of basic settings known as Options. 
These contain defaults that affect the manner in which the individual 
tools function.  
This way, you can configure the program to suit your own 
preferences. 
 

Setting the unit and reference scale 

Start by specifying the unit of length for the values you enter. You 
will use mm for this exercise.  

Before you do this, you are advised to select an empty drawing file 
to ensure that the new unit of length and reference scale only apply 
to the drawing file in which you are creating the title block. 

To select a new drawing file 

• Click  Open on a Project-Specific Basis and open an empty 
drawing file. Name it Title block and close all the other drawing 
files. 
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To set units 

1 Click  Options (Default toolbar). In the Options dialog box, 
select the Desktop environment page. 

2 Set the Enter lengths in option to mm. 

 

3 Click OK to confirm the settings. 
 

Tip: Alternatively, set the unit 
in the status bar: click in the 
field beside length and select 
mm for this exercise. 
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Now change the reference scale. Until now you have worked at a 
scale of 1:100.  
The title block will be drawn at a scale of 1:1. 

To set the reference scale 

1 On the View menu, click  Reference Scale. 

 

2 Click 1.00 in the Scale dialog box. 
 

Border of title block 

Start by drawing the outer border of the title block. 

To draw the outer border as a rectangle 

 Drawing file Title block is current; all the other drawing files are 
closed. 

1 Click  Rectangle in the Tools palette (Basic family - Draft 
module - Create area). 

2 The Rectangle Context toolbar opens. Select  Based on 
diagonal line. 

3 Place the first point in the workspace. 

Tip: Alternatively, set the 
reference scale in the status 
bar: click in the field beside 
Scale and select 1:1. 
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4 Diagonal point 
Enter a length of  170. Press the TAB key and enter 155 for 
the  width.  
Press ENTER to confirm. 

The rectangle is drawn. 

5 Click  Zoom All at bottom left in the viewport. 
 

Create the inner lines as lines parallel to the border. 

To draw the inner lines 

1 Click  Parallel Lines (Create area). 

 

2 Click the element 
Click the bottom line of the border. 

3 Through point or offset 
Enter 20 for the offset and  
Press ENTER to confirm. 

4 Which side? 
Click inside the rectangle. 

Tip: Did you make an 
incorrect entry?  
Click  Undo. You can undo 
all steps back to the last save. 



 

Basics Tutorial Unit 2: Designing and Modifying 2D Elements 165 
 

5 Number: 1. 

6 Point through which element is to pass or enter offset: 10. 
Number: 4. 

7 Point through which element is to pass or enter offset: 25. 
Number: 1. 

8 Point through which element is to pass or enter offset: 30. 
Number: 1. 

9 Point through which element is to pass or enter offset: 10. 
Number: 3. 

10 Press ESC to quit the tool. 

11 To draw the parallel lines that are vertical, click  Parallel Lines 
again. 

12 Click the left-hand side and create two parallel lines - one at an 
offset of 15 and the other at an offset of 120. 
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Deleting lines 

Finally, delete the lines you do not need. 

To delete lines and segments of lines 

1 Click  Auto-Delete Segment (Change area) and delete the 
superfluous vertical line segments.  

2 Click  Delete (Edit toolbar) and delete the vertical line on the 
left. 

3 Click  Auto-Delete Segment again and delete the superfluous 
horizontal lines. 
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Modifying the pen thickness 

The border of the title block needs to stand out. 

To modify the pen thickness 

1 Click the Properties tab in the Tools palette. 

 

2 To select the border of the title block, press and hold down the 
SHIFT key and click a line of the border. This selects all lines with 
the same group number. 
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3 The Properties palette shows the format properties of the selected 
lines, amongst others. 
Click the box beside Pen Thickness and select pen 3    0.50. 

 

4 To confirm, click in the workspace with the left mouse button. 

Tip: The  Modify Format 
Properties tool (shortcut 
menu or Edit toolbar) 
produces the same result. 
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Your drawing should now look like this: 
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Task 2: entering text for the title block 

The following part of the exercise involves entering the text for the 
title block using the tools in the  Text module (Tools palette, Basic 
family).  

Tools Objective 

 X Coordinate 
(delta point) 

 

 Y Coordinate 
(delta point) 

 Copy 

 Edit Text 

 Explode 
Paragraph 

 Change Text 
Parameters 
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Entering centered text 

Start by entering a label for the contents of the plan in the title 
block. 

To enter centered text 

 Switch to the Tools palette. 
Select the  Text module (Basic family). 

1 Click  Horizontal Text in the Create area of the Tools palette. 
 

 

The start point of the text will be exactly in the middle of the 
small rectangle - in other words, the midpoint of an imaginary 
diagonal line. 

2 Click in the workspace with the right mouse button. The shortcut 
menu (Point Assistant) opens. Select  Midpoint and click two 
diagonally opposite points. 
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3 Click  to expand the dialog box so that all the parameters are 
visible and enter the text parameters:  

• Click to  center the text's anchor point. 

• Text height: 5.00 mm 
The Text width adapts dynamically according to the Aspect 
ratio set (in this example: 1.00).  

• Line spacing: 2.00 

• Font: 8 ISONORM DIN 6776. 

 

4 For the text, enter Precast Balcony Unit, Type 12 

5 Click OK or press CTRL+ENTER.  
The  Horizontal Text tool remains active. 
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Paragraph text 

Enter the name of the construction project in the next field. It is to 
be left-aligned and you will enter the text as paragraph text. To 
enter paragraph text, you need to specify a value for the line 
spacing. 

Paragraph text:  
When  Paragraph text is active, the lines you enter will form a 
paragraph. The individual lines of text in a paragraph retain their 
original spacing regardless of the reference scale you set. The lines in 
a paragraph can also be addressed as a single entity for easy 
manipulation. 
To delete individual lines from a paragraph, use . 

 resolves a paragraph into lines. 

Line spacing:  
The spacing between lines is based on the line spacing value 
multiplied by text height. Whenever you press ENTER to confirm a 
line of text, the program automatically goes to the next line. 

Point snap: 
To position text exactly, use the point snap feature and enter an 
offset. This is very useful when you want to place a point relative to 
an existing point. 

To enter paragraph text 

 The  Horizontal Text tool should still be active.  
You will define the start point for the text by snapping a point 
and entering the offset value. 

1 Point to the point in the title block as shown below.  
Do not click the point! 

Allplan will use this point as the reference point (i.e. the values 
you enter are measured from this point). The point is marked with 
a cross.  
Now the values you enter for  and  are based on this 
reference point (the point snapped). To indicate this, the  X 
coordinate and  Y coordinate boxes in the dialog line turn 
yellow. 

Tip: You can use  to save 
combinations of text 
parameters as favorites:  
Use  to enter a name in 
the list and specify the 
parameters. 
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2 Enter a value of 30 for  dX, press the TAB key, enter a value 
of -5 for  dY and press ENTER to confirm. 

3 Change the position of the text's anchor point to  
 top left and  

activate  Paragraph text. 

4 Enter the following text: 
New Condominium [ENTER] 
With Underground Parking 

5 Press CTRL+ENTER or click OK to finish entering text. 

6 Press ESC to quit the tool. 
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Horizontal text 

Enter a line of text on the right in the title block and copy it to the 
fields below. 

To enter and copy text 

1 Click  Horizontal Text in the Create area of the Tools palette. 

2 Use the point snap feature to specify where you want the text to 
start: 
a) Point to the top left corner of the field  
 (see below) 
b)  dX = 2, TAB key 
c)  dY = -2 
d) Press ENTER to place the point 

 

3 Set the text's anchor point to  top left. Change the Text height 
to 2.5 mm and the Line spacing to 1.5. 
For the sample text, enter: Date. 
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4 Click OK to confirm. 

5 Press ESC to quit the tool. 

6 Left-click the text Date. 

7 Point to a part of the text that is not marked with a handle. 

8 Click  Copy on the context toolbar. 

 

9 From point or enter offset 
Click the top left corner of the field. 

 

10 To point or enter offset 
Enter 4 for the  Number of copies in the coordinate dialog box 
and click the top left corner of the field below. 

 

11 Press ESC to quit the tool. 
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Editing text 

Modify the text using the  Edit Text tool. 

Text modification: 
Text can be edited at any time. This provides a comfortable approach 
if you are using sample text - all you have to do is update the text. 

To edit text 

1 Click Date text at the top with the right mouse button. On the 
shortcut menu, select  Edit Text. 

The relevant dialog box appears and can be modified. 

2 Press ENTER at the end of the Date text to go to the next line and 
enter a placeholder for the date in the next line: XX. XX. 20XX 

Note: Make sure that  Paragraph text is active so that you can 
modify the two lines together. 

3 Click OK to confirm. 

4 Change the entries underneath and use placeholders as shown 
here following the instructions in steps 2 and 3. 
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Changing text parameters 

Change the appearance of the placeholder for the plan number. 
Assign it different text parameters. You will give it a character 
height of 5 mm and a character width of 6 mm. First, you need to 
'explode' the paragraph. 

Define text parameters: 
When you enter text, you can use one of the 20 Allplan fonts or you 
can use all the TrueType fonts you have installed. 
The Text Height and Text Width parameters are absolute values. 
This means that the text will print using the values you enter 
regardless of the selected reference scale. 

To change text parameters  

1 Click the Plan number... paragraph with the right mouse button. 
The shortcut menu opens. Select  Explode Paragraph. 

This explodes the paragraph and you can now modify each line 
separately. 

2 Press ESC to quit the  Explode Paragraph tool. 

3 Switch to the Properties palette. 

4 Click the placeholder XXX with the left mouse button. 
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5 The Properties palette shows the parameters of the selected text. 
Click the box beside Height and select 5.00 mm. 
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6 Click the box beside Width, enter 6.00 and press ENTER to 
confirm. 

 

7 Click in the workspace with the left mouse button. 

Note: You can also use the  Change Text Parameters tool 
(Tools palette - Text module - Change area or shortcut menu of 
the text you want to modify). 
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8 Complete the label using the information provided below. 
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Task 3: saving the title block as a symbol in the library and retrieving it 

In the last part of this exercise you will save the title block as a 
symbol in a folder of the library. Finally you will retrieve the title 
block and place it in an empty drawing file. 

Tools  

 Library palette  

 New group 

 Insert element 

 Insert symbol 

 Find 

Symbols 

Symbols are design entities that you can use whenever you need. 
Symbols automatically adapt to the scale of the drawing file. They 
can be addressed (click with the middle and left mouse buttons) and 
modified as a single entity. You can alter symbols and save them 
using another name. 

Symbols are often used for drawings and other common 
components. In time, you will find that you develop your own 
extensive libraries for title blocks, fixtures, equipment etc. that you 
can use time and again. 

Symbols in the library palette 

Symbols and other library elements (smart symbols, SmartParts) can 
be stored and managed in any folders in the library. You can create 
your own folders in the following data paths:  

Office: the folders in this path contain the office standard; they are 
available to the entire office: 

• Stand-alone computer: for all local projects  

• Computer on the network: for all local and remote users and 
projects Only the administrator can store and manage symbols. 

Project: the folders in this path belong to a particular project; they 
are available only in that project. 

Private: the folders in this path belong to the user that is currently 
logged on; they cannot be accessed by other users on the network.  
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Each folder can contain a large number of library elements. You can 
copy, delete and rename symbols in the Library palette or in 
Windows Explorer. 
 

Saving a symbol in the library 

Insert the title block as a symbol in a folder of the library. 

To insert a symbol in the library 

1 Open the Library palette. 

2 The title block is to be made available to the entire office. 
Open the Office folder. 
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3 Click  New group at the bottom of the Library palette. 

 

4 Enter Symbols for the name of the new group and press ENTER 
to confirm. 

 

5 Open the new Symbols folder. 

6 Again, click  New group at the bottom of the Library palette. 

7 This time, enter Title blocks for the name of the new group and 
press ENTER to confirm. 

8 Open the new Title blocks group. 
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9 At the bottom of the Library palette, click  Insert element and 
then  Insert symbol. 

 

10 Select element(s) you want to save as a symbol file 
Use the left mouse button to open a selection rectangle around 
the title block. It is displayed in the selection color. 

11 Set the symbol's base point  
Click the bottom right corner. This is the point at which the 
symbol will be attached to the crosshairs when it is retrieved. 

12 In the dialog box that appears, choose Dumb symbol without 
Snoop functionality and click OK to confirm. 

13 Enter Original for the name of the new symbol and click OK to 
confirm. 

 

Tip: You can also change the 
position of a symbol’s base 
point when you retrieve it. 
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14 This saves the new Original symbol to the Title blocks folder. 

 
 

Tip: You cannot see the 
symbol in the preview? Check 
that the Wireframe view type 
and the Plan view are active.  
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Retrieving a symbol from the library 

Now retrieve the symbol and place it in an empty drawing file. 

In practice, the new drawing file might be a drawing file for another 
construction project. All you would need to do then is change the 
project-specific information and save the title block again as a 
symbol - this time in the Project folder.  
Besides the symbols you create and save yourself, you can use this 
approach to retrieve symbols in the Allplan library. 

To retrieve a symbol from the library 

1 Click  Open on a Project-Specific Basis (Default toolbar), 
open a new, empty drawing file and close the drawing file with 
the Title block. 

2 On the View menu, click  Reference Scale and select 1 (1.000). 
Alternatively, click the Scale field in the status bar. 

3 As you have just saved the Original symbol, this folder is still 
open in the Library palette.  
If it isn't, click  to navigate through the Library palette or 
click  to find the file you need.  

4 If you want to  Find the file, enter its name in the line at the 
top of the Library palette. In this example, enter Original and 
press ENTER to confirm. 

The Library palette displays the file in question.  
Point to the illustration of the file to display a ToolTip with 
information on the file type (symbol in this example), the date 
the file was saved and the folder where it was saved 
(\Office\Symbols\Title blocks in this example). 
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5 Double-click the Original symbol with the left mouse button or 
drag it into the workspace. 

The symbol is attached to the crosshairs at its base point. 

6 To place the symbol, click in the workspace. 

7 If the title block appears too small, click  Zoom All in the 
border of the viewport. 

 

When placing the title block, you can use the input options to 
change the size of the title block by resizing it in the X and Y 
directions. First you define a fixed point and then you specify the 
resizing factors. 
 

Tip: Using the input options, 
you can change the position 
of the symbol’s base point 
and define a cursor snap 
angle. 
The tools on the shortcut 
menu help you define the 
symbol’s drop-in point 
precisely. 
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Additional tools for placing elements 

A number of tools is provided in the Input Options to help you place 
elements: 

 
Use this to position the drop-in point. 

Df Pnt 
You can use the default drop-in point. This is the point you have 
chosen when defining the smart symbol and/or symbol. 

Ang= 
Use this to switch between a fixed (‘0’) and freely definable (‘?’) 
drop-in angle. When you have selected ?, you can enter the angle 
after placing the element, or you can click a line and match its 
angle.  
Note: Using the + and - keys, you can rotate the element displayed 
attached to the crosshairs by a cursor snap angle in a clockwise or 
counter-clockwise direction. You can specify this angle using Cursor 
snap angle (see below). 

Num= 
Use this to define the number of the elements to be placed. Num=1 
places one element; Num=? any number of elements. 

Resize  
You can use this to resize the element in the X, Y and Z direction by 
first defining a fixed point and then specifying the resizing factors. 
Tip: When you activate Ang=? before you click Scale, you can 
define an angle and then resize the (smart) symbol you are about to 
place 
 

Snoop 
You can use this to rotate the element so that it is parallel to existing 
architectural lines (e.g. walls). This is done automatically when you 
position the cursor over the architectural line. In the case of (smart) 
symbols defined as Intelligent symbol/smart symbol with snoop 
functionality, the distance to the architectural line is based on the 
setting made when you defined the relevant (smart) symbol. For 
more information, see Intelligent (smart) symbols. ‘Normal’ (smart) 
symbols or elements from the Clipboard are placed using an offset 
value of 0. 
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Drop 
You can use this to define a custom drop-in point by clicking it in 
the dialog box. 

Attribute 
Here you can assign attributes to (smart) symbols. 

Cursor snap angle 
Here you can set the angle at which the element is rotated when you 
click the + or - keys. 
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Exercise 6: Precast Balcony Unit 
• Creating and modifying dimension lines 

• Hatching and hatching definition 
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Task 1: designing the precast balcony unit 

The first part of this exercise involves drawing the floor plan and 
two sections for a precast balcony unit. 
You will use the  Draft module in the Tools palette (Basic family).  

Tools: Objective: 

 Rectangle 

 

 Fillet 

 Parallel Lines 

 Auto-Delete Segment 

 Line 

 X Coordinate (delta 
point) 

 Y Coordinate (delta 
point) 

 Copy and Mirror 

 Midpoint 

 Stretch Entities 

 Fold Line 
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Initial settings 

Start by making initial settings. 

To select a new drawing file and set the options 

1 Click  Open on a Project-Specific Basis and open an empty 
drawing file. Enter Precast balcony unit for its name and close 
all the other drawing files. 

2 Click the Length in the status bar and select m. 

3 On the View menu, click  Reference Scale and select 25. 
 

You will start by drawing the outline. 

Bear the coordinate system in mind and the rotation direction of 
angles! 

 

To display the section you want, use the tools at the bottom of the 
viewport:  

 Zoom All  Zoom Section  
 

Tip: When you change the 
scale using the  Reference 
Scale tool on the View menu 
and define a scale using , 
you can also select this scale 
in the status bar. 
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You can also use the mouse to define the section that is displayed 
on screen: 

• Open the  Options - Desktop environment - Mouse and 
crosshairs: the Keeping the right mouse button pressed down - 
Zoom function option is selected by default. As a result, you can 
zoom using the right mouse button.  

• You can use the mouse wheel to dynamically enlarge or reduce 
the section displayed on screen.  

• Double-clicking the middle mouse button displays the screen 
contents in their entirety 

• You can pan by pressing and holding down the middle mouse 
button; a hand is displayed with the crosshairs.  
If you work with a two-button mouse (e.g. Mac computers), you 
can select the Ctrl + Shift + left mouse button held down - Pan 
function (for two-button mouse) option (  Options - Desktop 
environment - Mouse and crosshairs). 

 

Drawing the outline 

To draw the outline in plan 

1 Click  Rectangle in the Tools palette (Basic family - Draft 
module - Create area). 

2 The Rectangle Context toolbar opens. Select  Based on 
diagonal line. 

Note: Check that  Create rectangle as a polyline is not active 
in the input options, as you will edit individual lines of the 
rectangle later.  

3 Click where you want the rectangle to start. 

When you move the mouse, a preview of the diagonally opposite 
point is displayed attached to the crosshairs ("rubber-band"). 

4 Diagonal point 
Enter a length of  2.60. Press the TAB key and enter 1.05 for 
the  width.  
Press ENTER to confirm. 
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5 Click  Zoom All at bottom left in the viewport. 

6 Click  Fillet in the Tools palette (Basic family - Draft module - 
Change area). 

7 Trimming is displayed in the input options. When this button is 
active (default setting), Allplan automatically shortens or 
lengthens the initial lines as far as filleting starts. If trimming 
isn't active, click to activate it now. 

 

8 Click the left and right side of the rectangle and confirm the 
radius of the fillet proposed by the system. 

Allplan offers four options for applying a fillet. 
Select the semi-circle at the bottom. 

 

9 Click  Zoom All again. 

10 Press ESC to quit the  Fillet tool. 

11 Delete the bottom line of the rectangle. 
Right-click this line and select  Delete on the shortcut menu. 
(Alternatively, you can also select  on the Edit toolbar and 
then click the line). 

12 Press ESC to quit the tool. 
 

Tip: Did you make an 
incorrect entry? 
Click  Undo (Default 
toolbar). 
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Creating inner parallel lines 

Now you will draw the inner lines of the precast balcony unit. 

To create inner parallel lines 

1 Click  Parallel Lines in the Tools palette (Basic family - Draft 
module - Create area). 

2 Click the semi-circle you have just created. 

3 Enter 0.1 for the offset.  
Which side? 
Click within the outline; Allplan is copying the circle inwards.  
Press ENTER to confirm the number (1). 

4 For the next offset, enter 0.02.  
Which side? Click the inside again. 
Confirm the number (1). 

5 Click  again to create lines parallel to the lines on the sides. 

6 Click the line on the left and then the endpoints of the semi-circle 
one after the other (see below). 

 

7 Click  again to create lines parallel to the line at the top. 
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8 Click the line at the top and enter 0.1 for the offset. 

 

9 Click below the line to specify the side where you want to create 
the parallel lines. Confirm the number (1). 

10 Now create three parallel lines. Enter 0.02 for the first offset, 
0.04 for the second offset and 0.02 for the third offset. Confirm 
the number (1) each time. 

11 Press ESC to quit the tool. 
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Deleting redundant line segments and drawing fillets 

Delete the redundant line segments in the corners and complete your 
design by adding fillets. 
 

To delete redundant line segments and to add fillets  

1 Click one of the lines you want to delete with the right mouse 
button and select  Auto-Delete Segment on the shortcut 
menu. 
(Alternatively, you can also click  in the Change area and then 
click the relevant line). 

2 Click all the line segments you want to delete. 

Use  Zoom Section (at the bottom of the viewport) to set a 
suitable view. This tool appears when you move the cursor to the 
bottom of the viewport. 

3 Click  Line in the Tools palette (Create area). 

4 Draw the two fillets as shown below. 

Your drawing should now look like this: 

 

5 Press ESC to quit the tool. 
 

Tip: If you inadvertently 
deleted elements, you can 
quickly restore them by 
immediately double-clicking 
in the workspace with the 
right mouse button (the last 
action is undone). You can 
also use  Undo (you can go 
back (undo) as many steps as 
you want, as far back as the 
last time the data were saved 
and compressed.). 
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Drawing 'Isokörbe' 

Create the 'Isokörbe' (special type of reinforcement cage) at the top 
and on the sides. 

To draw 'Isokörbe' in plan 

1 Click  Line in the Tools palette (Create area). 

2 Click  Polyline on the Line Context toolbar. 

3 Point to the top left corner. 

Allplan will use this point as the reference point (i.e. the values 
you enter are measured from this point). The point is marked with 
a cross.  
Now the values you enter for  and  are based on this 
reference point (the point snapped). To indicate this, the  X 
coordinate and  Y coordinate boxes in the dialog line turn 
yellow. 

4 Press the TAB key to go to the  Y coordinate box. For dY, 
enter  
-0.50 and press ENTER to confirm. 

This defines the starting point of the line. 

5 Enter the following values in the dialog line: 
 dX = -0.08 
 dY = -0.40 
 dX =  0.08 
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6 Press ESC to quit the tool. 

 

7 Now draw the 'Isokorb' at the top using the procedure previously 
described. Careful with the direction and the sign 
(positive/negative)! 

 

8 You can create the 'Isokorb' on the right by mirroring. Select the 
'Isokorb' on the left by enclosing it in a selection window (from 
left to right) using the left mouse button.  

9 Click  Copy and Mirror. 
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10 To define the first point for the mirror axis, click the line at the 
top with the right mouse button and select  Midpoint on the 
shortcut menu. 

Make sure that you do not click the midpoint of the line or any 
other existing point.  
This defines the first point of the mirror axis. 

 

11 To obtain a mirror axis that is exactly vertical, press the TAB key 
to switch to the  Y Coordinate box in the dialog line.  
Enter any dY value (not equal to 0). 
This creates the 'Isokorb' on the right and completes the design. 

12 Press ESC to quit the tool. 
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Outline of longitudinal section 

Next you will draw the outline of the longitudinal section and place 
it below the floor plan. 

To draw the outline of the longitudinal section 

1 Click  Line in the Tools palette (Create area). 

2 Click  Polyline on the Line Context toolbar. 

3 Click  Select Pen Thickness on the Format menu and select 
pen thickness 0.50 mm in the list box. 

Note: While you are drawing, you can change the pen thickness 
on the Format toolbar at any time. 

4 Place the first point below the plan. 
Create the lines by entering the following values one after the 
other in the dialog line: 

 

Bear the coordinate system in mind! 

 dX = 2.60,  dY = 0.33,  dX = -0.10,  dY = -0.12 

 dX = -2.0,  dY = 0.12,  dX = -0.10,  dY = -0.33. 

Tip: If you have entered an 
incorrect value, click  on 
the Line Context toolbar. The 
last entry is deleted and you 
can resume your work at the 
end point of the previous line. 
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5 Press ESC to quit the tool. 
 

Modifying the outline 

The next step involves modifying the outline. 

To modify the outline of the longitudinal section 

1 Select the  Stretch Entities tool (Edit toolbar). 

2 Select the points you want to modify 
Click the bottom right point of the upstand on the left (see below) 

3 Place a point (from point) or enter dx:  
Enter 0.02 for dX in the dialog line, confirm dY and dZ (0). Press 
ESC. 

4 Click  Fold Line (Edit toolbar). 

5 Click the right line of the upstand. 

6 End point  
Point to the point at bottom right; this is the point you have just 
modified. Allplan snaps to this point, marking it with a cross. 
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7 Press the TAB key to activate the  Y coordinate, enter a value 
of 0.10 for dY and press ENTER to confirm. 

 

8 Press ESC to quit the tool. 

9 You should now be able to modify the upstand on the right 
yourself. When finished, press ESC to quit the  tool. 

10 Select pen thickness 0.25 on the Format toolbar and draw the 
'Isokorb' on the left using  Line (Tools palette - Create area). 
Start at bottom left. 

 dX = -0.08 
 dY = 0.18 
 dX = 0.08 

 

11 Press ESC to quit the  Line tool. 

12 Create the 'Isokorb' on the right-hand side of the longitudinal 
section using  Copy and Mirror: 
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• Use the left mouse button to enclose the 'Isokorb' in a 
selection rectangle (from left to right). 

  

• Point to a line and click  Copy and Mirror on the context 
toolbar. 

• Right-click the line at the top and select  Midpoint on the 
shortcut menu. 

• Press the TAB key to switch to the  Y coordinate in the 
dialog line and enter any value for dY. 

Your design should now look like this: 

 

13 Press ESC to quit direct object modification. 
 

Drawing the cross-section 

Finally, you will draw the entire cross-section in a single operation. 
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To draw the cross-section 

1 Select pen thickness 0.50 mm and click  Line (Tools palette - 
Create area). 

2 Click  Polyline on the Line Context toolbar. 

3 Place the starting point at top so that it is to the left of the floor 
plan. 

4 Enter the following values one after the other in the dialog line.  
Compare your result with the graphics on the left. 

 

 dX = 0.33  ENTER 
 dY = -2.35 ENTER 

 
 dX = -0.33  ENTER 
 dY = 0.10  ENTER 

 
 dX = 0.02  TAB  
 dY = 0.02  ENTER 

 
 dX = 0.07  ENTER 

(press TAB key to switch to ) 

 dX = 0.04  TAB  
 dY = 2.05  ENTER 

 dX = 0.02  TAB  
 dY = 0.02  ENTER 

(press TAB key to switch to ) 

 dY = 0.04  ENTER 
 dX = -0.13  ENTER 

(press TAB key to switch to ) 

 dX = -0.02  TAB  
 dY = 0.02  ENTER 

(press TAB key to switch to ) 

 dY = 0.10 

5 Press ESC to quit the tool. 

Tip: Skip a coordinate:  
pressing the TAB key takes 
you to the next data entry 
box.  
 
Enter relative coordinates:  
Enter values for ,  and 

 in the dialog line (use the 
TAB key to switch between 
the data entry boxes) until 
you find the drop-in point. 
Press ENTER to place the 
point. 
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6 Select pen thickness 0.25 mm and complete the 'Isokorb' (8/18 
cm) at the top. 

Your drawing should now look like this: 
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Task 2: dimensioning the precast balcony unit 

Now you will dimension the precast balcony unit using the tools in 
the  Dimension Lines module (Tools palette - Basic family). 

Tools: Objective: 

 Horizontal dimension 
line 

 

 Vertical dimension line 

 Parallel Lines 

 Auto Dimensioning 

 Add Dim. Line Point 

 Modify Dim. Line 

  

  

  

  

The first step is to define the dimension line parameters. 
Dimensioning then involves three steps: 

• Define the type of dimension line (vertical, horizontal, angle or 
direct) 

• Specify a location for the dimension line 

• Click the points you want to dimension 

You can modify dimension lines at any time: for example, you can 
add and delete dimension line points, move dimension lines and 
change the settings for dimension line parameters. 

Tip: In the  Options on the 
Dimension line page, you can 
set a tolerance value for tilted 
(dimension) text, specify the 
decimal separator and enter 
values for blanking. 
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Setting dimension line parameters 

Start by making settings for the dimension line parameters. 

The most important parameters are the unit, the position of the 
dimension text, and the dimension text height and width.  
Dimension lines always reference the design dynamically (dimension 
lines are associative; the points you click are the reference points). 
Dimension lines automatically update to reflect any changes you 
make to the design. 

To set dimension line parameters  

1 In the Tools palette, select the  Dimension Lines module (Basic 
family). 

2 Click  Dimension Line (Create area).  

 

3 Click  Properties. 
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4 Check the settings in the top (general) part of the dialog box, 
select an Arrowhead (slash), enter its Size (3.00) and set the 
Format properties for the individual components of the 
dimension line. 

 

All dimension lines are created with the pen, line, color and layer 
set here, regardless of the settings on the Format toolbar. 

5 Check the settings on the Text tab in the bottom part of the 
dialog box and set the text parameters as shown below. 

6 Select a font and define the dimension text height and width by 
entering the following values: 

- Dimension text height: 2.50 mm 

- Aspect: 1.25 (as a result, the text width is 2.0) 

7 To define the Position of the dimension text, click the upper box 
in the middle. 
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8 Open the Dimension Text tab and check the following 
parameters: 

• Dimension text unit: m, cm 

• Round-off value in mm: 5 

• Number of decimal places: 3 

• Number of trailing zeros: 2 

• Exponent format option: selected 

 

9 Open the Input Options tab and select the No extension lines 
option. 
Set the Offset between dimension lines in mm/inch (paper) to 9. 
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10 Click  at bottom left and save the parameters as a favorite file. 
Enter "Tutorial" for its name. 

 

11 Click Save to confirm. 

12 Click OK to confirm the Dimension Line dialog box. 
 

Creating horizontal dimension lines 

You will now dimension the longitudinal section using horizontal 
dimension lines. 

To create horizontal dimension lines  

 The  Dimension Line tool is still open. 

1 Set the view so that there is enough space at the top for the 
dimension line. 

2 On the Context toolbar, click  Horizontal. 
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3 Through point or click dimension line 
Define the position of the dimension line by clicking above the 
longitudinal section. This is the point through which the 
dimension line will pass. 

4 Click the six points you want to dimension. 

A preview of the dimension line is displayed immediately. Any 
new points you click are automatically included in this preview. 
You can click the points to be dimensioned in any sequence. 

5 To finish adding points, press ESC. 

 Horizontal remains active so that you can create the next 
dimension line. 

6 Through point or click dimension line 
Click below the longitudinal section to define the point through 
which the dimension line is to pass. 

7 Click the points to be dimensioned and press ESC to finish 
creating horizontal dimension lines. 

 
 

Creating vertical dimension lines 

Now you will continue with vertical dimension lines. 

To create vertical dimension lines  

 The  Dimension Line tool is still open. 

1 On the context toolbar, click  Vertical. 

2 Click to the left of the longitudinal section to define the point 
through which the dimension line is to pass. 
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3 Click the corners of the 'Isokorb' and the upstand and press ESC 
to quit the tool. 

 Vertical remains active so that you can create the next 
dimension line. 

4 Through point or click dimension line 
Point to the left of the dimension line as the next dimension line 
is to be created to the left of the first one. 

Allplan snaps to this dimension line and displays it in the 
selection preview color. A symbol indicates the side on which the 
new dimension line will be created. 

 

5 Click in the workspace to confirm. 

6 Click the points to be dimensioned. 

7 Now you should be able to create the missing vertical dimension 
lines in the section and on the right yourself. 

 
 

Tip: You can specify the 
offset between the individual 
dimension lines in the  

 Properties. You can  
also move dimension lines 
later using the  Move 
Dimension Line tool. 
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Creating dimension lines automatically 

A part of the floor plan will be dimensioned automatically. All you 
need to do is draw a line through the components. Allplan will 
automatically dimension the points where the line and the 
components intersect. 

To create dimension lines automatically 

1 Click  Auto-Dimensioning in the Tools palette (Create area). 

2 Click  Match parameters from dimension line and click an 
existing dimension line. 

3 Click above the floor plan to define the point through which the 
dimension line is to pass. 

4 Place direction point 1 or enter a direction angle or line: confirm 
the value 0.00. 

5 Place point 1 for the section: define the first point by clicking 
above the 'Isokorb' to the left of the exterior edge of the precast 
element. 

6 Place the next point for the section: click the equivalent point on 
the right. 

7 Place the next point for the section: press ESC twice to quit the 
tool. Allplan automatically dimensions all the points where the 
line and the design intersect. 
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Adding dimension line points 

As the dimensions of the 'Isokörbe' are still missing, you will now 
add the relevant dimension line points.  

Any changes you make to the design using modification tools will 
automatically be reflected in the dimension lines if all the dimension 
lines are in the same drawing file or if the drawing file with the 
dimension lines is open in edit mode. 

There are times when you will find that dimension line points are 
missing or no longer required as the design has changed. In these 
cases, you do not need to create new dimension lines. You can 
simply add or delete dimension line points. 

To add dimension line points  

1 Using the right mouse button, click the dimension line to which 
you want to add dimension line points and on the shortcut menu, 
click  Add Dim. Line Point. 
(Alternatively, you can also select  Add Dim. Line Point in the 
Tools palette - Change area, and then click the dimension line). 

2 Click the points to be dimensioned (left and right exterior edges 
of the 'Isokörbe'). 

 

3 Press ESC twice to quit the tool. 
 

Tip: To remove a dimension 
line point, click  Del Dim. 
Line Point (Tools palette - 
Change area) and then a 
point on the dimension line. 
You can also use the shortcut 
menu. 
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It is also possible to change the parameter settings of dimension lines 
(apart from the spacing between dimension lines). 

• Click  Modify Dim. Line. 

 

- Set the new dimension line parameters in the  Properties 
and then click the dimension lines to apply the changes. 
You can also use the parameters of dimension lines you have 
already created. Click  Match parameters from dimension 
line and click the dimension line whose settings you want to 
use. 

- You can also use the context toolbar to select a dimension 
line type to which you want to apply the new parameters and 
then enclose all the dimension lines in a selection rectangle. 
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• You can also modify dimension lines by clicking a dimension line 
with the right mouse button and selecting Properties on the 
shortcut menu. 
Depending on the dimension line section clicked, you can change 
arrowheads or alter other parameters using the Properties palette. 
Any changes you make apply to the clicked section only. 
Use  and  to toggle between the individual dimension line 
sections or elevation points. 
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Complete the dimension lines as shown below: 
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Task 3: applying hatching to precast balcony unit and printing it 

The following part of the exercise involves applying hatching to the 
sections of the precast balcony unit using the tools in the  Draft 
module (Tools palette - Basic family). 
 

Tools: Objective: 

 Hatching  

 

 Area detection 

 Convert Surface Element 

 Reshape Surface  
Element, Architectural 
Area 

 Show/Hide  

 Print Preview 

 Print 
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Defining and creating hatching 

In the first step, you will select a hatching style that represents 
reinforced concrete and apply it to the longitudinal section of the 
precast balcony unit. 

To define and create hatching  

1 Click  Hatching in the Tools palette (Basic family -  Draft 
module). 

2 Click the button with the hatching style on the Hatching Context 
toolbar. 

 

3 The Hatching dialog box opens. Select hatching style 7. 

4 Make additional hatching settings as you require. 

• Line spacing area: 
Constant in layout, as set in defaults 

• Reference point area: 
Origin 

Tip: When you click the 
hatching number on the 
Hatching Context toolbar, 
you can quickly select a 
hatching style in the 
following dialog box: 
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5 Click OK to confirm the dialog box. 

6 Click  Area detection (input options, icon must be pressed in). 

7 Click within the area to which you want to apply hatching. The 
system will detect the boundary of the area automatically. 

8 Press ESC to finish defining the area. 

 

9 Press ESC to quit the tool. 
 

Tip: To apply hatching to 
rectangular areas, click two 
diagonally opposite points. 
Then press ESC. 
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Changing the hatching style 

The next step is to replace the hatching style for reinforced concrete 
with a hatching style for precast elements. All you need to do is 
change the hatching style. 

To change the hatching style 

1 Click  Convert Surface Element in the Tools palette (Basic 
family -  Draft module - Change area). 

2 The Convert Surface Element dialog box is displayed. Make 
settings as shown below and click the button with the hatching 
style. 

 

3 Select hatching style 6 in the Hatching dialog box (see "Defining 
and creating hatching" on page 221) and click OK to confirm. 

4 Select surface elements to convert to hatching 
Click the hatching you have applied to the longitudinal section. 

 

5 Press ESC to quit the tool. 
 

Tip: To change the hatching 
style, you can also click the 
hatching with the right 
mouse button and select 
Properties on the shortcut 
menu. The program opens the 
Properties palette where you 
can modify the hatching 
parameters (see above). 
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Cutting out hatching around the dimension text 

Now you will remove the hatching around the dimension text. 

To cut out hatching around the dimension text  

1 Click  Reshape Surface Element, Architectural Area in the 
Tools palette (Basic family -  Draft module - Change area). 

2 Select element to modify:  
click the hatching applied to the longitudinal section. 

3 Clear the Polygonize elements check box in the input options 
and select  Minus.  

 

By switching off Polygonize elements in the input options, you 
automatically deactivate  Area detection. 

4 Enclose the area around the dimension line in a selection 
rectangle using the left mouse button and press ESC twice. 
The hatching disappears. 

5 Repeat steps 2 and 4 for the second dimension line. 

 
 

Tip: You can also apply white 
fills to dimension text. 

To do this, select the Apply 
fill to dimension text check 

box in the  Properties of 
the dimension line, Text tab. 



 

Basics Tutorial Unit 2: Designing and Modifying 2D Elements 225 
 

Applying hatching to the cross-section 

Using the procedure described above, you will now apply hatching to 
the cross-section as shown below: 
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Printing the screen contents 

Finally, you will create a quick printout of the precast element. 
Using quick print, you can print intermediate results directly without 
having to assemble a layout first. For example, you can quickly print 
details or sections of floor plans if you need the current edit status 
on paper. 

To create quick printouts, you can use the  Print and  Quick 
Print tools (on the File menu) and the  Print Preview tool 
(Default toolbar): 

• Allplan uses the settings (for example, margins, header, footer, 
construction lines) you have specified in the Print Preview 
palette. There you can also set a scale and define the section you 
want to print. 

• You can use the  Print tool to print the current contents of the 
viewport on a printer you select in advance.  

• If you want to print the current contents of the screen without 
selecting print settings beforehand, you can use  Quick Print 
on the File menu. In this case, Allplan uses the default printer. 

To print the contents of the screen 

1 Click  Print Preview (Default toolbar). 

 

The menus and toolbars disappear and the Print Preview palette 
opens. 

2 Define the settings for print preview in the Settings, Margins and 
Display of elements areas. 

In the Display of elements area, select the Thick line option. This 
not only makes the different line weights visible on screen but 
also ensures that they are printed as such. 
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Using the Print construction lines option, you can choose to 
include construction lines in the printout. Define the other 
options as you need. 

 

3 If you want, you can set the scale in the Display of elements 
area. 

4 In the Settings area, you can select the Printer if you do not 
want to use the default printer. 
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Note: Click the  Settings icon to specify the properties (for 
example, paper and color options) of the selected output device 
or the raster driver set. 

 

5 Click Print at the bottom of the palette. 

The program sends the document to the selected printer. 

6 In order to exit print preview, click Close at the bottom of the 
palette. 

Note: To create more printouts, click  Quick Print on the File 
menu. Allplan immediately starts printing using the most recent 
settings. You do not see any prompts. 
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Unit 3: 3D Modeling 
 The exercise in this unit requires the  3D Modeling module in 

the Bonus Tools family. Check the Palettes to see whether you 
have licensed this module.  

Unit 3 provides an introduction to the 3D Modeling 
module. You will create a chair based on the zigzag chair 
designed by Gerrit T. Rietveld. You will learn 

 How to create the initial elements in 3D 

 How to automatically create a 3D solid based on a 
profile and a path 

 How to define a work plane so that you can draw in a 
sloping plane as if you were working in plan 

 How to design a box and use it to create the opening 
in the back of the chair 
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Exercise 7: Rietveld Chair 
This exercise involves creating a chair based on the zigzag chair 
designed by Gerrit T. Rietveld. 

 

You will use the tools in the  3D Modeling module (Bonus Tools 
family).  
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Task 1: designing the initial elements 

You will start by drawing the profile and the elevation view of the 
chair as 3D elements in plan. After this, you will rotate these 3D 
elements in space. 

 

Tools: Objective: 

 3D Rectangle 

 

 3D Line 

 Rotate 3D Elements  
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Designing the 3D elements 

Start by creating the profile and elevation of the chair using the 3D 
Rectangle and 3D Line elements. 

To draw the cross-section and profile of the chair in 
plan  

 

1 Click  Open on a Project-Specific Basis and open an empty 
drawing file. Name it Rietveld chair and close all the other 
drawing files. 

2 Go to the Tools palette and select the  3D Modeling module 
(Bonus Tools family). 

3 Click  3D Line in the Tools palette (Create area). 

4 To draw the profile of the chair, select  3D Rectangle on the 
3D Line Context toolbar. 

 

5 Click  Based on diagonal line in the input options.  

6 Click where you want the rectangle to start. 
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7 The length of the rectangle in the x-direction is 0.03 m. Enter  
 dx = 0.03 in the dialog line. Press the TAB key. This takes 

you to  dy. 

8 The height of the rectangle in the y-direction is 0.37 m. Enter  
 dy = 0.37 in the dialog line. 

9  dz is set to 0.00. Do not change this value. Press ENTER to 
confirm. 

10 Click  Zoom All in the border of the viewport. 

11 To create the elevation of the chair, select the  3D Line option 
on the 3D Line Context toolbar.  

 

12 Make sure  Polyline is selected in the input options. 

13 Click the bottom right corner of the rectangle to define the first 
point of the line. 

14 To draw the first line, select  Delta point in the dialog line, 
enter  dx = 0.265 and press ENTER to confirm. 

15 Enter the following values in the dialog line 
 dx = -0.265 TAB 
 dy = 0.40     ENTER 

 

16 To draw the third line, enter  dx = 0.325 in the dialog line and 
press ENTER to confirm. 

17 To draw the fourth line, enter the following values in the dialog 
line: 

 dx = 0.05 TAB 
 dy = 0.27 ENTER 

 

Tip: Pressing the TAB key 
takes you to the next data 
entry box in the dialog line. 
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18 Press ESC twice to quit the  3D Line tool. 

19 To get an impression of how the elements look in 3D, click  
 3 Viewports on the Window menu. 

You can now see the elements in plan, isometric and elevation 
view. 

20 Open the View menu and click Zoom All in All Viewports. 

Now your screen should look like this: 

 

Keep these 3 viewports for the steps that follow. 
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Rotating the 3D elements 

The 3D elements are still ”flat on the floor" (x-y plane). The next 
step is to rotate the 3D elements in space. The difference between 
this and rotating elements in 2D is that you can define an axis of 
rotation which lies freely in space (in 2D, you can only enter a point 
of rotation). 

To rotate the 3D elements 

 The  3D Modeling module is still open. 

1 Select  Rotate 3D Elements (Change area) and click the 
elevation of the chair. 

The element is displayed in the selection color. 

2 Define the bottom line of the chair’s elevation view as the axis of 
rotation. First click the left point of the line. The sequence in 
which you enter the points is important for defining the angle 
later. 

3 Click the right point of the line. This defines the axis of rotation. 
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4 Rotate the elevation view upwards by 90 degrees. Enter 90 and 
press ENTER to confirm. 
Now the rotated elevation view of the chair should only be 
visible as a straight line in plan view (see below). 

5 Next rotate the profile of the chair downwards. 

To do this, click the profile and define the axis of rotation as 
shown below. Make sure you click the point at the top first. 

 

6 Enter the angle of rotation: 90. 

7 Open the View menu and click Zoom All in All Viewports. 

Tip: You can use the ‘right 
hand rule' to determine the 
positive direction of the 
rotation angle. Point the 
thumb of your right hand in 
the direction of the rotation 
axis; your fingers will indicate 
the positive direction of 
rotation. 
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Now your screen should look like this: 

 

8 Press ESC to quit the  Rotate 3D Elements tool. 
 

 
 



 

238 Exercise 7: Rietveld Chair Allplan 2017  

Task 2: designing the 3D solids 

You will create the chair from the 3D elements. Start by designing 
the opening in the back of the chair as a 3D solid (box). You will 
then subtract this opening from the back of the chair. 

 

Tools: Objective: 

 Extrude Along Path  

 

 Work Plane   

 Box 

 Subtract and Remove Solid 
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Extruding along a path 

The next step is to create the chair using the Extrude Along Path 
tool. The profile you want to extrude is the profile of the chair. The 
elevation of the chair will serve as the path. 

To extrude the elevation of the chair along a path 

 The  3D Modeling module is still open. 

 3 Viewports are open. 

1 Click  Extrude Along Path (Create area). 

2 Select profile to extrude 
Click the profile of the chair in isometric view. 

3 Select path 
Click the elevation of the chair in isometric view. 

 

4 Set parameters, press ESC to confirm 
Check the settings in the Extrude Along Path dialog box and 
press ESC to confirm. 
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5 Open the View menu and click Zoom All in All Viewports. 

Now your screen should look like this: 

 

6 Press ESC to quit the  Extrude Along Path tool. 
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Defining a work plane and creating a 3D box 

The chair is still missing the opening in its back. You will start by 
creating it as a box. To make it easier for you to position the box in 
the sloping back of the chair, you will define a work plane (= user-
defined coordinate system) whose x-axis and y-axis are parallel to 
the edges of the back of the chair. This way, you can draw in the 
work plane as if you were working in plan. 

 

To define the work plane and create a 3D box 

 The  3D Modeling module is still open. 

 3 Viewports are open. 

1 Click in the viewport displaying the chair in plan. 

2 To enter the work plane, display the chair in isometric view. Click 

 Rear, Left Isometric View. 
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The result should look like this: 

 

3 Open the View menu, point to Toolbars and click Special. 

4 Click  Work Plane on the Special toolbar. 

 

5 To define the origin of the work plane, click the bottom left 
corner in the back of the chair (see below). 
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6 Choose No at the following prompt asking whether you want to 
use the current view as the work plane. 

 

Define the work plane by entering four points. 

7 To define the x-axis, click the two end points of the bottom edge 
of the chair (see below). As the positive x-axis is to be to the 
right, click the point on the left first. 

8 To define the y-axis, click the two end points of the rear left edge 
of the chair (see below). As the positive y-axis is to be upwards, 
click the bottom point first. 

 

The z-axis, which is generated automatically in the origin, is 
perpendicular to the x-y plane. 
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Your screen should look like this: 

 

Now all the entries you make apply to the axes of the defined 
work plane: You can enter the values defining the box as if you 
were working in a 2D floor plan. 

9 Click  Box (Create area). 

10 Check that Based on diagonal line is active in the input options. 
If it isn't, activate it now. 

 

Always work in the viewport on the right! 

11 Make sure that  Delta point is active in the dialog line.  
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12 Point to the point at top left to define the reference point for the 
corner of the box. You can see this point in the other two 
viewports, too. 

 

13  Delta point is active.  
Now enter the offset of the corner in the dialog line:  

 dx = 0.1 
 dy = -0.1 

 

Press ENTER to confirm. 

This defines the corner of the box. 

14 Enter dx = 0.17 for the length of the opening and dy = 0.05 for 
its width. Then press ENTER to confirm. 

15 To define the height of the box in the z-direction, enter a value 
that is larger than the thickness of the back of the chair. Enter -
0.10 for the height. You have drawn the box. 

16 Click  Plan to return to the normal work plane. 
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Now your screen should look like this: 

 

17 Press ESC to quit the  Box tool. 
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Creating the cutaway 

To finish, you will remove the volume of the box you have just 
created from the 3D element. This will delete the box.  

To add a cutaway 

 The  3D Modeling module is still open. 

1 Click  Subtract and Remove Solid (Create area) to create the 
cutaway in the back of the chair and to delete the box. 

2 Click 1st solid 
Click the chair; this is the solid in which you want to create the 
cutaway. 

3 Select solids, click right mouse button to confirm 
Click the box; this is the (only) solid you want to subtract from 
the first solid. Click the right mouse button to confirm. 
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This creates the cutaway; the resulting chair should look like this 
(view type is set to Hidden at bottom right in the border of the 
viewport): 
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A note on design check, color and texture 

To check the design 

1 Press the F4 key.  

A viewport of the Animation view type opens, showing the chair. 
 Navigation Mode is active. 

 

See also: you can find more information on mouse movement in 
animation in the help for Allplan. See "Sphere mode, camera 
mode". 

2 Press and hold down one of the mouse buttons, then drag: you 
are navigating the virtual model in sphere mode, which is set by 
default.  
Pressing the CTRL key at the same time switches to camera 
mode. 

3 Experiment with the navigation modes and start trying things out 
on your own.  
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4 The chair's color is boring? What about red? 
 Navigation Mode is still active in the animation window. 

Right-click the chair; the shortcut menu opens. 
Click  Set Surface. 

The Modify Surfaces palette opens.  
You can check and change the surface properties of the chair. 

5 Click the button in the Color area. 

 

The palette shows the current color of the chair. 
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6 In the Color system area, click the button beside Color name. 
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7 Select a color by clicking it. 

 

The palette shows the old color and the new color. 

Tip: You can also select a 
color in the color circle, use 
the slide bar or enter values 
in the Define color area. 
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8 Click OK to confirm the palette.  

You can now customize the surface for your needs by defining 
more properties.  

9 Finally, click OK to confirm the palette. 

The chair appears in the selected color. 
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10 Or what about the wood grain? Would you like to see it?  
Right-click the chair in the animation window and select 

 Set Surface on the shortcut menu. 

In the Modify Surfaces palette, go to the Color area and click the 
button beside Texture. 
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11 Open the contents in the design folder in the office standard. 
In order to do this, click the Office folder followed by the 
Contents folder. 

12 Select a texture and click OK to confirm. 
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13 Continue to modify the surface. Define settings that are similar to 
those shown below. When you have finished, click OK to 
confirm. 

 

 

Tip: You can find the  Save 
as a favorite tool at the 
bottom of the Modify 
surfaces palette. Using this 
tool, you can save the surface 
with a new name (for 
example, 
wood_chair.surf). 
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The result might look like this: 

 
 



 

258  Allplan 2017  

 



 

Basics Tutorial Index 259 
 

2 
2D entities to 3D  238, 247 

3 
3D 

2D entities to 3D  238, 247 
3D line  232 
extrude along path  238, 239 
rectangle  232 
rotate  231, 235 

A 
additional tools 

division point  96, 106 
polar coordinates  106 
reference point  39 

animation  249 
area detection  83 
auto-delete segments  97, 103, 

161, 166, 192, 198 
axis of rotation  235 

B 
basic settings  21 

options  30 
settings in the tools palette  27 
track tracing  29 

box  241 
brackets  61 

C 
circle  38, 68, 96 
color  249 
construction lines  106, 114, 226 
contact  3 
copy  39, 50, 59, 61, 80, 106, 

114, 170, 175 
copy drawing file  58 
copying and mirroring  39, 53, 

97, 114, 192, 199, 203 

D 
data path  182 

design check  249 
dimension line 

horizontal  212 
vertical  213 

dimension line parameters  209 
save  209 
set  209 

dimensions  208 
add dim. line point  216 
automatic  215 
horizontal  212 
set parameters  209 
vertical  213 

drawing file status  19 

E 
element filter 

element  77, 80 
enter  30 
enter points  39 
extrude along path  238, 239 

F 
favorite  209 
file cabinet  38 

design  39 
modify  58 

filter assistant  50 
full circle  114 

H 
hatching  77 

definition  86, 221 
exclude region  224 
modify  84, 223 

horizontal text  118 

I 
intersect 2 entities  96, 97, 103 

L 
label style  160 
labeling  118 
library  182 

Index 



 

260 Index Allplan 2017  

linear snap  69, 106 

M 
midpoint  37, 39, 49, 53, 57, 171, 

192, 199, 203 
modification 

dimension lines  216 
hatching  84 
modify offset  58 
stretch entities  58 

modification tools  58 
modify offset  58 
modules 

3D modeling  230, 231, 238 
dimension line  208 
draft  39, 68, 96, 161, 192, 231 
layout  160 
text  118, 170 

O 
objectives  8, 9, 10, 11 
office 

data path  182 
options  30 
origin of work plane  241 
outline detection  221 

P 
plan view  241 
point of intersection  39, 67, 114 
point snap and offset entry  39 
polar coordinates  106 
polyline entry tools  90 
precast balcony unit 

apply hatching  220 
design  192 
dimension  208 

print  226 
print preview  226 
print screen contents  226 
private 

data path  182 
project 

create project  16 
data path  182 
path for settings  16 

purlin roof  96 
design  96 
label  118 

R 
rectangle  39, 40, 47, 57, 96, 97, 

103, 161, 163, 192, 194 
rectangle based on centerline  

103 
reference point  39 
requirements  2 
retaining wall with drainage  67 

design  68 
hatching  77 

Rietveld chair 
3D design  238 
draft and design in 2D, 

convert to 3D  231 
extrude along path  238, 239 

rotate  231, 235 

S 
saving 

dimension line parameters  
209 

favorite  209 
select pen and line type  31 
Show/Hide  32 
sources of information  4 

additional help  5 
stretch entities  58 
symbols 

data path  182 
general  182 
output  187 

symbol's base point  182 

T 
text 

text anchor point  118, 171, 
173, 175 

text height  118, 171, 173, 
175, 178 

text width  118, 171, 178 
texture  249 
title block 

design  161 
label  170 
symbol  182 

tools 
2D entities to 3D  238, 247 
3D line  232 



 

Basics Tutorial Index 261 
 

box  238, 241 
circle  38, 68, 96 
construction lines  106, 114, 

226 
copying and mirroring  39, 53, 

97, 114, 192, 199, 203 
extrude along path  238, 239 
fold line  203 
horizontal text  118 
intersect 2 entities  96 
line  69, 80, 97, 106, 198, 199, 

202, 203, 205 
modify elements  84 
modify offset  58 
parallel lines  58, 65, 97, 103, 

161, 163, 192, 196, 208 
print  226 
print preview  226 
rectangle  38, 96, 232 
rotate  235 
stretch entities  58 
subtract and remove solid  

238, 247 
work plane  238, 241 

training, coaching and project 
support  6 

troubleshooting  36 
checklist  36 
troubleshooting  36 

U 
understanding drawing files  19 
user-defined coordinate system, 

see work plane  241 

V 
Viewport toolbar  32 

W 
work plane  230, 241, 247 

X 
x axis of work plane  241 

Y 
y axis of work plane  241 

Z 
zigzag chair  229 

 


	Contents
	Before You Start ...
	Requirements
	Feedback
	Sources of information
	Additional help
	Tips on efficient usage
	User forum (for Serviceplus customers)
	On the Internet: solutions to frequently asked questions
	Feedback on the help


	Training, coaching and project support

	Unit 1: Introduction
	Objectives
	Exercise 1: File Cabinet with Drawers
	Exercise 2: Retaining Wall with Drainage
	Exercise 3: Purlin Roof
	Exercise 4: Rotary
	Exercise 5: Title Block
	Exercise 6: Precast Balcony Unit
	Exercise 7: Rietveld Chair

	Creating the project
	Understanding drawing files
	Drawing file status

	Basic settings
	Palette configuration
	Settings in the Tools palette
	Track tracing
	Options
	Pen settings

	Controlling on-screen display
	Tools on the viewport toolbar

	How to ...
	What if  …
	And what if ...


	Unit 2: Designing and Modifying 2D Elements
	Exercise 1: File Cabinet with Drawers
	Task 1: designing the file cabinet
	Drawing the file cabinet as a rectangle
	A note on creating a rectangle as a polyline

	Drawing the file cabinet using offset polyline
	A note on direction in which the offset polyline is entered

	Designing drawers
	A note on placing points using point snap and offset entry

	Creating the knob
	Copying the drawer
	Mirroring drawers
	Creating a knob for the door in the middle

	Task 2: modifying the file cabinet
	Copying a drawing file
	Stretching entities
	A note on selecting and modifying several elements and regions together using the brackets

	Adding a frame


	Exercise 2: Retaining Wall with Drainage
	Task 1: designing a retaining wall with drainage
	Retaining wall of angular shape
	Drainage

	Task 2: hatching
	Applying hatching to the retaining wall
	Copying the outline of the retaining wall
	Applying hatching using area detection
	Modifying hatching
	Hatching defaults
	Polyline entry tools
	Input options for entering polylines, overview
	Additional tools in the dialog line



	Exercise 3: Purlin Roof
	Task 1: designing a purlin roof
	Slab and rafters
	Ridge purlin and collar beam
	Construction lines
	Nails

	Task 2: labeling the purlin roof
	Labeling
	Creating leaders


	Exercise 4: Rotary with Three Roads
	Task 1: designing a rotary with one road
	Rotary with one road
	Traffic island for road
	Filleting the road and traffic island

	Task 2: pattern
	Creating closed outlines
	Applying a pattern to the road
	Applying a pattern to the rotary
	Applying a pattern to the traffic island
	Defining a new pattern
	Applying the new pattern

	Task 3: completing the design
	Creating the missing roads
	Pattern line


	Exercise 5: Title Block
	Task 1: designing the title block
	Setting the unit and reference scale
	Border of title block
	Deleting lines
	Modifying the pen thickness

	Task 2: entering text for the title block
	Entering centered text
	Paragraph text
	Horizontal text
	Editing text
	Changing text parameters

	Task 3: saving the title block as a symbol in the library and retrieving it
	Saving a symbol in the library
	Retrieving a symbol from the library
	Additional tools for placing elements


	Exercise 6: Precast Balcony Unit
	Task 1: designing the precast balcony unit
	Initial settings
	Drawing the outline
	Creating inner parallel lines
	Deleting redundant line segments and drawing fillets
	Drawing 'Isokörbe'
	Outline of longitudinal section
	Modifying the outline
	Drawing the cross-section

	Task 2: dimensioning the precast balcony unit
	Setting dimension line parameters
	Creating horizontal dimension lines
	Creating vertical dimension lines
	Creating dimension lines automatically
	Adding dimension line points

	Task 3: applying hatching to precast balcony unit and printing it
	Defining and creating hatching
	Changing the hatching style
	Cutting out hatching around the dimension text
	Applying hatching to the cross-section
	Printing the screen contents



	Unit 3: 3D Modeling
	Exercise 7: Rietveld Chair
	Task 1: designing the initial elements
	Designing the 3D elements
	Rotating the 3D elements

	Task 2: designing the 3D solids
	Extruding along a path
	Defining a work plane and creating a 3D box
	Creating the cutaway

	A note on design check, color and texture


	Index

